Avid recommends that you read all the information in this ReadMe file thoroughly before installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which contains the latest information that might have become available after the documentation was published.

If you are upgrading to this version of the Interplay software, see “Database Upgrade for Interplay v2.0 Interplay Engine or Archive Engine” on page 14.

Before installation Interplay Transfer on a new system, see “Problems Performing a Clean Install of Interplay Transfer v2.0” on page 46.
Other patents are pending.

6,933,948; 6,961,801; 7,043,058; 7,081,900; 7,103,231; 7,266,241; 7,280,117; D392,269; D396,853; D398,912.

6,763,134; 6,766,063; 6,791,556; 6,810,157; 6,813,622; 6,847,373; 6,871,003; 6,871,161; 6,901,211; 6,907,191; 6,928,187;

6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,618,547; 6,636,869; 6,678,461; 6,687,407; 6,704,445; 6,747,705;

6,393,948; 6,961,801; 7,043,058; 7,081,900; 7,103,231; 7,266,241; 7,280,117; D392,269; D396,853; D398,912.

Other patents are pending.

This document is supplied as a guide for Avid Interplay. Reasonable care has been taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers' losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2008 Avid Technology, Inc. and its licensors. All rights reserved.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are "commercial computer software" or "commercial computer software documentation." In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, ALEX, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid DNxHD, AVI drive, AVI drive Towers, Avid DS Assist Station, Avid ISIS, Avid Learning Exellencier, Avid Liquid, Avid Mojo, AvidNet, AvidNetwork, Avid Remote Response, AVI Stripe, Avid Unity, Avid Unity ISIS, Avid Xpress, AVoption, AVX, CamCutter, Chrome Curve, Curve Wheel, DAE, Dazzle, Deko, Deko Cast, D-Fi, D-Fx, DigiDelivery, Digi design, Digi design Audio Engine, Digi design Intelligent Noise Reduction, DigiDrive, Digital Nonlinear Accelerator, Digi Trans lat or, DINR, DNxchange, do more, D-Verb, Equinox, Expert Render, Face Robot, FACE ROBOT, FASTBREAK, Fast Track, FieldPad, Film Composer, FilmScribe, Fluid Motion, FX Deko, HIIP, Hyper SPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, iNEWS, iNEWS Control Air, Instinct, Interplay, Intraframe, iS9, iS18, iS23, iS36, Iso Sync, LaunchPad, Lightning, Lo-Fi, Magic Mask, make move move | media, Marquee, Matador, Maxim, MCM express, MCX press, Media Browse, Media Composer, Media Dock, Media Dock Shuttle, Media Fusion, Media Illusion, Media Log, Media Reader, Media Recorder, MEDIA rray, Media Share, Media Stream, Meridien, Meta Fuze, Meta Sync, Micro Track, Mission Control, Natural Match, Near archive, Net Review, News Cutter, Nitris, OMF, OMF Interchange, OMM, Open Media Framework, Open Media Management, PCTV, Pinnacle Media Suite, Pinnacle Studio, Pinnacle Systems, Pro Encode, Pro Tools, Quiet Drive, Recti-Fi, Retro Loop, rS9, rS18, Scr ipt Sync, Secure Production Environment, Show Center, Soft Image, Sound Designer II, SPACE, SPACESHift, Spectra Graph, Spectra Matte, SteadyGlide, Symphony, TARGA, Thunder, Thunder Station, TIMELINER, Trilligent, Unity RAID, Vari-Fr, Video RAID, Video Slave Driver, Video SPACE, Xdeck, and X-Session are either registered trademarks or trademarks of Avid Technology, Inc. in the United States and/or other countries.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.

Avid Interplay Version 2.0 ReadMe • 0130-07648-03 C • September 2009 • Created 9/18/09 • This document is distributed by Avid in online (electronic) form only, and is not available for purchase in printed form.
Replacing 32-Bit Media Indexers with 64-Bit Media Indexers ................. 29
32-Bit Media Indexer File Count and Client Count ......................... 29
Additional Information for Interplay Media Services v2.0 Upgrade ........ 31
Additional Information for ProEncode Upgrades .......................... 31
Additional Information About the Server Execution User .................. 32
Changing the Server Execution User in a Clustered Environment ....... 33
Additional Information About Pro Tools .................................... 33
Video Satellite Support ....................................................... 34
Establishing the First Connection Between Pro Tools and Interplay .... 34
Using Antivirus Software in an Interplay Environment ..................... 35
Monitoring the Integration of Journal Files into the Database .......... 35
Macintosh Installer for Interplay Access Client .......................... 36
Avid Unity MediaNetwork v5.x Support .................................. 36
Operating Points for Sony XDCAM HD and XDCAM EX ..................... 36
Operating Points Qualified for Omneon Servers .......................... 39
Operating Points Qualified for AirSpeed Multi Stream ...................... 39
Interplay Documentation ................................................................ 40
Documentation Changes ......................................................... 41
Improving Search Response Time ............................................. 41
Clip and Video ID Naming Conventions ..................................... 41
Archive Engine Installation .................................................... 41
New for Interplay v2.0 .......................................................... 42
Limitations ............................................................................ 46
Problems Performing a Clean Install of Interplay Transfer v2.0 .......... 46
New Limitations for Interplay v2.0 .......................................... 47
Limitations on Locator Text ..................................................... 48
Long GOP (Assist and Instinct) ................................................. 49
Media Indexer Upgrade Installation .......................................... 49
AVC-Intra Resolution ............................................................. 49
Relinking Offline Media for Precomputes .................................... 50
Interplay Access and Force-Delete Locked Media ........................... 50
Changing Source Information for a Clip in Interplay ...................... 50
ISIS v2.0, ISIS v1.5.1 and Media Indexer Servers .......................... 52
MultiRez ........................................ 87
Send to Playback .................................. 87
Send to Workgroup .................................. 87
Working with Panasonic P2 and Ikegami NLTEK Media ................. 88
Using the Import and Export Method with P2 Media in an Interplay Environment ........................................ 89
  Supported Panasonic Drivers ................................ 89
  Upgrading to this Release from Interplay v1.1.2 or Earlier .......... 89
  Configuring a Local Media Indexer to Index a P2 Reader or P2 Store . . 90
  Changing P2 Cards in the Reader ................................... 90
  Working with Media that Spans Multiple Cards ................... 91
  Mounting Drives and P2 Cards on Avid Unity MediaNetwork ........ 92
  Importing from a Copy of a P2 Card on Shared Storage ............ 92
  Limitations and Troubleshooting P2 Media ....................... 95
Using an Ikegami Field Pack in an Interplay Environment ............. 96
Hardware and Software Requirements

Interplay Server Slot Locations

For information on the slot locations for the various Interplay servers, see the Avid Interplay Software Installation and Configuration Guide.

Supported Software

The section also describes backwards compatibility between editor and Interplay releases. It also lists the supported software for Avid Interplay v2.0.

Avid Editing Application Compatibility with Interplay Releases

In this section, the term Interplay components refers to the following:

- Media Indexer
- Interplay Access
- Service Framework
- (optional) Interplay Transfer client
- (optional) ProEncode client

The Interplay components are available on the “Install Editor Support” page of the Interplay Installer DVD. Each Interplay version has its own Installer DVD.
The following table matches Avid editing application software releases with supported Interplay releases. An S indicates that the editor is supported in this Interplay environment. An R identifies the corresponding Interplay release that the editor software shipped with. **In an Interplay environment, you must always install this version of the Interplay components on the corresponding editor.**

### Interplay Versions

<table>
<thead>
<tr>
<th>Avid Editing Application</th>
<th>v2.0</th>
<th>v1.6.2</th>
<th>v1.6</th>
<th>v1.5.1</th>
<th>v1.5</th>
<th>v1.4.2</th>
<th>v1.4</th>
<th>v1.2.4</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC v2.8.1, NC v6.8.1, Sym v1.8.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v2.8.3, NC v6.8.3, Sym v1.8.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v2.8.4, NC v6.8.4, Sym v1.8.4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>MC v3.0, NC v7.0, Sym v3.0 (Windows XP and Windows Vista)</td>
<td>S</td>
<td>S</td>
<td>R</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v3.0.5, NC v7.0.5, Sym v3.0.5</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>R</td>
<td>S</td>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v3.1.1, NC v7.1.1, Sym v3.1.1 and MC v3.1.2, NC v7.1.2, Sym v3.1.2</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>R</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>MC v3.1.3, NC v7.1.3, Sym v3.1.3</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>R</td>
<td>S</td>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v3.5, NC v7.5, Sym v3.5</td>
<td>S</td>
<td>S</td>
<td>R</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v3.5.1, NC v7.5.1, Sym v3.5.1</td>
<td>S</td>
<td>S</td>
<td>R</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v3.5.4, NC v7.5.4, Sym v3.5.4</td>
<td>S</td>
<td>R</td>
<td>S</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MC v4.0.1, NC v8.0.1, Sym v4.0.1, MC v4.0.2, NC v8.0.2, Sym v4.0.2</td>
<td>R</td>
<td>S</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Moving Editors Between Interplay Releases

Each editor has a matching Interplay release as shown by the “R” in the previous table. The release contains the qualified Interplay components for that editor. You can connect an editor to different Interplay environments but you must install the qualified set of Interplay components on the editor. For example:

- If you connect an Interplay v2.0 NewsCutter® editor (NC v8.0) to Interplay v1.6, use the Interplay v2.0 Installer DVD to install the Interplay components on that editor.
- If you connect an Interplay v1.6.2 NewsCutter editor (NC v7.5.4) to Interplay v2.0, use the Interplay v1.6.2 Installer DVD to install the Interplay components on that editor.
Running Media Services on older editors in an Interplay v2.0 environment.

If you are using Media Services and Interplay Access on older editors in an Interplay v2.0 environment, you must install the “Interplay Media Services Client Updater for Access” on the older editors. This allows your older version of Access to connect to the newer Media Services engine to use features such as “Interplay Media Services Status”. The installer is on the Interplay v2.0 Installer DVD. For additional information, see the Interplay Software Installation and Configuration Guide.

Running Interplay Assist and Editing Applications on the Same System

The following limitations apply to running Assist and an editing application (such as NewsCutter, Media Composer®, or Avid Instinct™) on the same computer:

- Because the two applications share the same libraries, the Assist release and the editor release must be from the same “bundle”. This means that for a given editor release you must install the corresponding R release of Assist (from the Interplay Versions table). For example:
  - Media Composer v3.1.x and Avid Assist v1.5 can be installed on the same system
  - NewsCutter v7.0 and Assist v1.4 can be installed on the same system
- Do not run Interplay Assist and an Avid editing application on the same computer at the same time. Performance and functionality are not guaranteed in this combination because the applications are not designed to share the computer resources.
- If you uninstall one of the applications you will uninstall some shared .dlls. In that case you must reinstall the application that you want to use.

Vista Requirements

The following limitations apply when matching release versions:

- The Windows® Vista® editors from Interplay v1.4.2 and v1.4 are not supported on Interplay releases earlier than v1.2.3.
- Standalone Interplay Transfer on Vista is not supported on Interplay v1.2.3 or earlier.
Interplay and Supporting Software Components

The following table lists the software components for Interplay v2.0.

Supported Software for Interplay Components and Related Software

<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid Interplay products</td>
<td></td>
</tr>
<tr>
<td>Avid Interplay Installer DVD</td>
<td>v2.0</td>
</tr>
<tr>
<td>Avid Interplay Engine</td>
<td>v2.0</td>
</tr>
<tr>
<td>Avid Interplay Archive Engine</td>
<td>v2.0</td>
</tr>
<tr>
<td>Avid Interplay Access&lt;sup&gt;a&lt;/sup&gt;</td>
<td>v2.0</td>
</tr>
<tr>
<td>Avid Interplay Assist</td>
<td>v2.0</td>
</tr>
<tr>
<td>Avid iNEWS&lt;sup&gt;®&lt;/sup&gt; Instinct</td>
<td>v2.1, v2.5</td>
</tr>
<tr>
<td>NVIDIA driver for Assist and Instinct</td>
<td>v182.65</td>
</tr>
<tr>
<td>Avid Interplay Transfer</td>
<td>v2.0</td>
</tr>
<tr>
<td>Microsoft Windows Vista 64 Business support for Standalone Interplay Transfer</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Windows XP support</td>
<td>SP2 and SP3&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Avid Interplay Media Services</td>
<td>v2.0</td>
</tr>
<tr>
<td>Avid Interplay ProEncode&lt;sup&gt;™&lt;/sup&gt;</td>
<td>v2.0</td>
</tr>
<tr>
<td>Avid CaptureManager&lt;sup&gt;™&lt;/sup&gt;</td>
<td>v4.2.0.5</td>
</tr>
<tr>
<td>32-bit Avid Service Framework</td>
<td>v1.3.0</td>
</tr>
<tr>
<td>64-bit Service Framework (for 64-bit Media Indexer)</td>
<td>v1.3.0</td>
</tr>
</tbody>
</table>

<sup>a</sup> Interplay Access supports Windows XP, Mac<sup>®</sup> OS<sup>®</sup> X 10.4.x, and Mac OS X 10.5.x. Access is the only Interplay application that runs on Mac OS.

<sup>b</sup> Interplay Assist, Avid Instinct, Standalone Interplay Transfer, and Interplay servers that support Windows XP Professional support both SP2 and SP3.
The following table lists the related software components for Interplay v2.0.

**Supported Software for Interplay Components and Related Software**

<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Productivity Tools</strong></td>
<td></td>
</tr>
<tr>
<td>Avid AirSpeed®</td>
<td>v2.7.2</td>
</tr>
<tr>
<td>Avid AirSpeed Multi Stream</td>
<td>v1.2</td>
</tr>
<tr>
<td>AirSPACE™</td>
<td>v2.9.5</td>
</tr>
<tr>
<td>Avid Low Res Encode bootset</td>
<td>v1.5.0.2140</td>
</tr>
<tr>
<td>Avid Low Res Encode root disk image</td>
<td>v2.3</td>
</tr>
<tr>
<td>SGL Flashnet™ (used for Interplay Archive)</td>
<td>v6.1.3</td>
</tr>
<tr>
<td>Avid Neararchive™</td>
<td>v1.7.11</td>
</tr>
<tr>
<td>Avid Thunder®</td>
<td>v7.1.1</td>
</tr>
<tr>
<td><strong>Encoding providers</strong></td>
<td></td>
</tr>
<tr>
<td>Telestream FlipFactory™</td>
<td>v6.1</td>
</tr>
<tr>
<td>Anystream™ Agility® (used for ProEncode)</td>
<td>v5.7.2</td>
</tr>
<tr>
<td><strong>Avid Unity products</strong></td>
<td></td>
</tr>
<tr>
<td>Avid Unity MediaNetwork</td>
<td>v5.1.x, v4.2.4,</td>
</tr>
<tr>
<td></td>
<td>v4.1.6</td>
</tr>
<tr>
<td>Avid Unity ISIS™</td>
<td>v2.0.x, v1.5.1a</td>
</tr>
<tr>
<td><strong>Avid iNEWS Products</strong></td>
<td></td>
</tr>
<tr>
<td>iNEWS Server</td>
<td>v2.8.6</td>
</tr>
<tr>
<td>iNEWS Client</td>
<td>v2.8.6</td>
</tr>
<tr>
<td>Command</td>
<td>v2.3.0.13</td>
</tr>
</tbody>
</table>

*a. See “Support for ISIS v1.5.x and ISIS v2.0.x on Media Indexer Servers” on page 26.*
Windows Server 2003 Support

The following Interplay servers support Windows Server 2003:

- Interplay Engine
- Interplay Archive Engine
- Interplay Media Indexer
- Avid CaptureManager
- Serial Control Server (used with CaptureManager)


⚠️ Avid recommends that you do not apply SP2 to an SR2500 server running Windows Server 2003 SP1. Some SR2500 models experience multiple reboot problems after upgrading to SP2. If you have already successfully applied SP2 to an SR2500 then you can stay at SP2. Otherwise, don’t apply the upgrade. Always check with your Avid representative before upgrading Interplay servers, especially cluster servers.

Upgrading a Cluster System to Windows Server 2003 SP2

A product recovery DVD is now available for upgrading a cluster system to Windows Server 2003 SP2. If you plan to use the product recovery DVD to upgrade an existing system, contact your Avid representative and schedule a maintenance window to perform the operation. The recommended procedure involves backing up the Interplay database, reimaging both systems, and rebuilding the cluster without deleting the database. Use “Avid Interplay Product Recovery, Avid Interplay Engine Cluster”, 0010-09516-04A.

Important Information in This ReadMe

The following lists some of the important sections of this ReadMe.

- For description of the new features for this release, see “New for Interplay v2.0” on page 42.
- For information on ISIS® v1.5 and v2.0 client software on Media Indexer servers, see “Support for ISIS v1.5.x and ISIS v2.0.x on Media Indexer Servers” on page 26.
- For information on using Panasonic P2 and Ikegami NLTEK media on Avid shared storage, see “Working with Panasonic P2 and Ikegami NLTEK Media” on page 88.
- It’s important to not store more than 20,000 items in a folder in the Interplay database. See “Folder Limitations” on page 81.
International Character Support

Interplay includes international character support (ICS). ICS allows you to display and input characters in languages other than English.

Interplay applications are qualified on an English operating system running locales for the following languages:

- Simplified Chinese and Traditional Chinese
- Japanese
- French, Italian, German, and Spanish

For additional information on using ICS, see *International Character Support* on the Avid Knowledge Base.

Installing and Configuring Interplay Software

To install the software and begin the configuration of your Interplay environment, use the *Avid Interplay Software Installation and Configuration Guide*.

Upgrading Interplay Software

To upgrade the software, see the following topics:

- “Updating Intel Drivers on Cluster Systems” on page 13
- “Database Upgrade for Interplay v2.0 Interplay Engine or Archive Engine” on page 14
- “Updating the Avid Interplay Engine Software” on page 19
- “Additional Information for the Service Framework Lookup Service” on page 28
- “Additional Installation Information for Media Indexer” on page 28
- “Additional Information for ProEncode Upgrades” on page 31
- “Macintosh Installer for Interplay Access Client” on page 36

Updating Intel Drivers on Cluster Systems

Do not install or update Intel® NIC drivers on Interplay Engine cluster systems after the cluster setup is complete. Due to the technical aspects of changing resources and devices on a cluster, this can lead to problems with the cluster software and possible data loss. For additional information, see “Additional Information for Avid Unity ISIS” on page 26.
Database Upgrade for Interplay v2.0 Interplay Engine or Archive Engine

The Interplay engine database schema changed at Interplay v2.0. When you upgrade an Interplay system to Interplay 2.0, the database change requires a migration of existing databases. The migration is performed automatically when a database is first loaded by the Interplay engine. The automatic migration can take up to 10 minutes for large databases.

Avid recommends that you schedule downtime for the system when upgrading a cluster to the latest Interplay version.

The best way to upgrade the Interplay Engine is to do the following:

1. Back up the Interplay Engine database.
2. Lock and deactivate the database.
3. Perform the installation.
4. Activate the database.

If you follow this procedure, the database upgrade occurs while you are logged into the Interplay Administration tool. If you don’t do this, it might take place at an inopportune time such as when a user logs on to Interplay Access or Assist for the first time after the upgrade. In this case the system could appear to hang at the “Connecting” message while the database update occurs.

⚠️ Once migrated, the database cannot be loaded by earlier versions of the Interplay Engine. If you need to access the database through an earlier version, contact your Avid representative.

Upgrading from Interplay v1.1.4 Though v1.1.6

The Interplay v1.1.6 ReadMe instructions for a cluster upgrade required that you create or modify a registry key value during the upgrade to prevent the Interplay Engine from failing over while the system was updating the database. This step is no longer required. You should check whether the registry key exists on both nodes and delete it.

To delete the registry key value:

1. Open regedit on the active node.
2. Delete the following registry key.
   HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\Workgroup\Avid Workgroup Resource DLL
3. Perform the same operation on the non-active node.
The deletion is effective immediately and does not require a restart.

**Backing Up the Interplay Engine Database**

You use the Interplay Administrator to create backups of the database (see the *Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide*). However, the Administrator does not back up the complete database folder. Before you perform an upgrade, use the following procedures to create a backup copy of the complete database folder (AvidWG or AvidAM) and the user database folder (_InternalData).

Before you create a backup copy, determine the location of the database folder and whether the database was split between the Interplay Engine and a shared storage workspace.

**To determine the location of the database folder:**

1. On the Interplay Engine, open a Command Prompt and type the following command:
   ```
   net share
   ```
   All shares on the system are displayed. By default, WG_Database$ (a hidden administrative share) represents the root folder of the database.
   - For a non-cluster system, the root folder is usually D:\Workgroup_Databases.
   - For a cluster system, the root folder is S:\Workgroup_Databases

2. Navigate to the root folder and double-click the AvidWG folder (or AvidAM folder for an Archive Engine).
   By default, this folder includes all database folders and files, as shown in the following illustration:
You need to back up the entire AvidWG folder.

If the AvidWG folder includes only the _Database folder, then the Interplay Engine is using a split database.

For some split databases, the Workgroup_Databases folder might incorrectly include all database folders. To verify if the split database is active, open both _PropertyStore folders and check for recent timestamps. The folder on shared storage should show recent activity. For more information about split databases, see the “Recommendation for Database Storage” in the Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.

To determine the location of the second (split) database folder:

- Navigate to the workgroup.xml file and open it in a text editor.

This file is located in the Interplay Engine installation directory, for example,

- C:\Program Files\Avid\Avid Interplay Engine\Data\Apache\Conf\workgroup.xml (non-cluster systems)
- S:\WorkgroupData\Apache\conf\workgroup.xml (cluster systems).

Both database paths should be listed, for example:

- \InterplayServer\WG_Database$ 
- \UnityServer\WorkspaceName
Both of these folders hold an AvidWG folder. You need to back up both AvidWG folders.

**To make a backup copy of the database on a non-cluster system:**

1. Open the Interplay Administration tool.
2. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
   c. Click Lock Database.
3. Click Menu and click Manage Databases.
4. Select the AvidWG database and click Deactivate. Select AvidAM for an Archive Engine.
5. Click Menu and click the Restart Server view.
6. Click Restart Server and close the Interplay Administration tool.
7. Use a backup tool to make a copy of the following folders and record their location.

---

**Interplay Engine or Interplay Archive Engine**

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (Interplay Engine database)</td>
<td>D:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidAM (Archive Engine database)</td>
<td>D:\Workgroup_Databases\AvidAM</td>
</tr>
<tr>
<td>_InternalData (user database if engine is a</td>
<td>\D:\Workgroup_Databases_InternalData</td>
</tr>
<tr>
<td>Central Configuration Server)</td>
<td></td>
</tr>
</tbody>
</table>

---

**Interplay Engine (Split Database)**

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (_Database folder only)</td>
<td>D:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidWG (all other database folders)</td>
<td>\UnityServer\WorkspaceName\AvidWG</td>
</tr>
<tr>
<td>_InternalData (user database if engine is a</td>
<td>\D:\Workgroup_Databases_InternalData</td>
</tr>
<tr>
<td>Central Configuration Server)</td>
<td></td>
</tr>
</tbody>
</table>
Use a backup tool that can handle long path names (longer than 255 characters). For example, perform a backup with Robocopy (from the Microsoft Windows Resource Kit) or use a tool such as 7-ZIP (free download) to zip the folder.

Depending on the size of your database, this kind of backup can take a long time. To save time you can temporarily move the _Backups folder from within the AvidWG (or AvidAM) folder, to another location. After you perform the copy you can move the folder back under AvidWG.

To make a backup copy of the database on a cluster system:

1. Open the Interplay Administration tool.
2. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
   c. Click Lock Database.
3. Click Menu and click Manage Databases.
4. Select the AvidWG database and click Deactivate. Select AvidAM for an Archive Engine.
5. Close the Interplay Administration tool.
6. Click Start and select Programs > Administrative Tools > Cluster Administrator.
7. Open the Groups folder.
8. Select the Avid Workgroup Server group.
9. Select the Avid Workgroup Server resource and take it offline.
10. If you performed the previous step correctly, drive S: should still be accessible within the Windows environment. If it is not available, use the Cluster Administration tool to put drive S: online by clicking on the disk resource within the “Avid Workgroup Server Group” and selecting online.
11. Use a backup tool to make a copy of the following folders and record their location.

### Interplay Engine or Interplay Archive Engine

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (Interplay Engine database)</td>
<td>S:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidAM (Archive Engine database)</td>
<td>S:\Workgroup_Databases\AvidAM</td>
</tr>
<tr>
<td>_InternalData (user database if engine is a Central Configuration Server)</td>
<td>S:\Workgroup_Databases_InternalData</td>
</tr>
</tbody>
</table>
Interplay Engine (Split Database)

<table>
<thead>
<tr>
<th>Folder Name</th>
<th>Default Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>AvidWG (_Database folder only)</td>
<td>S:\Workgroup_Databases\AvidWG</td>
</tr>
<tr>
<td>AvidWG (all other database folders)</td>
<td>\UnityEngine\WorkspaceName\AvidWG</td>
</tr>
<tr>
<td>_InternalData (user database if engine is a</td>
<td>S:\Workgroup_Databases\InternalData</td>
</tr>
<tr>
<td>Central Configuration Server)</td>
<td></td>
</tr>
</tbody>
</table>

Use a backup tool that can handle long path names (longer than 255 characters). For example, perform a backup with Robocopy (from the Microsoft Windows Resource Kit) or use a tool such as 7-ZIP (free download) to zip the folder.

Depending on the size of your database, this kind of backup can take a long time. To save time you can temporarily move the _Backups folder from within the AvidWG (or AvidAM) folder to another location. After you perform the copy you can move the folder back under AvidWG.

12. Before you perform the upgrade, bring all of the resources inside the cluster resource group online. Right-click the resource group and select Bring Online.

For more information on the Cluster Administration tool, see the *Avid Interplay Failover Guide*.

Updating the Avid Interplay Engine Software

The following topics describe how to update the Interplay Engine and Interplay Archive Engine software:

- “Upgrading an Interplay Engine Cluster or Interplay Archive Engine Cluster” on page 19
- “Checking the Server Execution User Account on a Cluster System” on page 21
- “Upgrading a Non-Cluster Interplay Engine or Interplay Archive Engine” on page 22
- “Activating the Database” on page 23
- “Verifying the Upgrade” on page 25

Upgrading an Interplay Engine Cluster or Interplay Archive Engine Cluster

The process described here is similar to a rolling update except that the database is locked and deactivated before you begin.
If you are using a roaming profile, it is important to install both nodes in exactly the same order.

To upgrade an Interplay Engine cluster or Interplay Archive Engine Cluster:

1. Verify that you have a valid backup as described in “Backing Up the Interplay Engine Database” on page 15.

2. If you took the Avid Workgroup Server resource offline when you performed a backup, bring all of the resources inside the cluster resource group online. Right-click the resource group and select Bring Online. For more information, see the final steps in “Backing Up the Interplay Engine Database” on page 15.

3. Check the Server Execution User account. See “Checking the Server Execution User Account on a Cluster System” on page 21. Check the Avid Workgroup TCP COM Bridge service login, the Cluster service login, and the registry key value that the installer uses. All three values should match.

If you deactivated your database when backing it up in Step 1, proceed to Step 34.

4. Open the Interplay Administrator tool on the Active node.

5. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
   c. Click Lock Database.

6. Use the following steps to deactivate the database:
   a. Click Menu in the Interplay Administration tool and click Manage Databases.
   b. Select the AvidWG database and click Deactivate. For an archive database, select AvidAM.

7. Use the Interplay v2.0 Installer DVD to update the Interplay Engine or Interplay Archive Engine software. Use the following procedure:
   a. Determine which is the active node (first node).
   b. Use the following procedure to move all resource groups to the active node:
      In the Cluster Administrator, open the Groups folder and check the owner column for the following groups: Avid Workgroup Server group, Cluster group, and the MSDTC group. If they are not on the active node, right-click the group entries under the Groups folder and select Move Group for each entry.
c. Run the Interplay Installer on the non-active node (second node). Select the Custom install option. Select the defaults but make sure you supply the correct Server Execution User values when prompted. See “Checking the Server Execution User Account on a Cluster System” on page 21. Restart as requested and continue with Part 2 of the installation. The installer will ask you to restart again after Part 2.

d. Perform the installation on the first node. Use the Custom install option and specify the correct Server Execution User when prompted. Then restart the first node.

e. During the installation, the installer displays a dialog box that asks you to move the Avid Workgroup Server group to the second node. You don’t have to move the group at this point. Click OK and the system automatically moves the appropriate groups and failover to the second node. Restart as requested and continue with Part 2 of the installation. The installer asks you to restart again after Part 2.

The dialog box that asks you to move the Workgroup Server group is only relevant when you are performing a rolling upgrade. In a rolling upgrade, users can work on the active node while you update the inactive node. In this case the database is locked and deactivated so it is not a rolling upgrade.

After completing the previous steps, both nodes in the cluster are updated to the new software version.

8. After you update both nodes, follow the procedure in “Activating the Database” on page 23.

Checking the Server Execution User Account on a Cluster System

The Server Execution User is a Windows operating system user account that is used to run the Interplay Engine process. The account was set up when the Interplay Engine software was initially installed. If the NXNServerUser.exe tool has never been used to change the Server Execution user on your cluster system, you can skip this section. If you aren’t sure whether the account was ever changed, use the procedure in this section to check the values.

If the three values in this section do not match and you accept the default Server Execution User during the upgrade, the cluster will not fail over after you complete the upgrade.

For additional information, see “Additional Information About the Server Execution User” on page 32.

To determine the Server Execution User name on a cluster system:

1. Right-click My Computer and select Manage.
2. Select Services.
3. Right-click Avid Workgroup TCP COM Bridge and select Properties.
4. Click the Log On tab.
   The Log On tab contains the name of the Server Execution User.

5. Right-click the Cluster service, select Properties, and click the Log On tab. This is the Windows user account that is running the cluster service.

   *On a cluster system, the Windows user account that is running the cluster service must match the Server Execution User account.*

6. Check the following registry key value on each node:
   
   HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\Workgroup\Avid Workgroup Server
   
   Check the ExecutionUser value. The Interplay Engine installer uses this value as the default value for the Server Execution User. If this value does not match the TCP COM Bridge value, it means that the Server Execution user has been changed at some point since the original Interplay Engine installation. In this case, use the Custom install option and do not use the value that automatically appears when the system asks for the Server Execution User name.

   If all three values match, then either the Server Execution User was never changed at this site or the cluster-aware version of the NXNServerUser.exe tool was used to change the user. In this case you can either use the Typical install option or use the Custom install option and accept the Server Execution user value that the installer displays.

   If the account names are different, use the Custom install option when you upgrade the Interplay Engine software and supply the correct credentials of the Cluster Service name and password when prompted. Use the Cluster Service’s regular domain name, such as “MYDOMAIN\ServerUser” and not the fully qualified domain name, such as “MYDOMAIN.com\ServerUser”.

   If you don’t know the correct password for the Server Execution User account and you have to change the value during the upgrade, use the cluster-aware version of the NXNServerUser.exe to change the user before you perform the upgrade. See “Changing the Server Execution User in a Clustered Environment” on page 33.

### Upgrading a Non-Cluster Interplay Engine or Interplay Archive Engine

**To update the Avid Interplay Engine software:**

1. Verify that you have a valid backup as described in “Backing Up the Interplay Engine Database” on page 15.

   *If you deactivated your database when backing it up in Step 1, proceed to Step 46.*

2. Open the Interplay Administrator tool.
3. Use the following steps to lock the database:
   a. Click Lock/Unlock Databases.
   b. Select the database in the Unlocked Databases list.
   c. (Option) Type a Lock comment explaining why you are locking the database.
   d. Click Lock Database.

4. Use the following steps to deactivate the database:
   a. Click Menu in the Interplay Administration tool to see the display of Administration tool views.
   b. Click Manage Databases.
   c. Select the AvidWG database and click Deactivate. For an archive database, select AvidAM.

5. Use the Interplay v2.0 Installer DVD to update the Interplay Engine software. Follow the onscreen instructions. For additional information, see the Avid Interplay Software Installation and Configuration Guide.

6. After you update the software, follow the procedure in “Activating the Database” on page 23.

**Activating the Database**

After you perform the upgrade, you must activate the database. The Interplay Engine software performs the database update when you activate the database.

1. Use the Interplay Administrator tool to activate the database and perform the database upgrade as follows:
   a. Open the Interplay Administrator tool on the system running the Interplay Engine.
   b. Click Manage Databases.
   c. Type the following in the “Database (.pro) file to activate” text box.

      ```
      \engine_name\WG_Database$\AvidWG\AvidWG.pro
      \engine_name\WG_Database$\AvidAM\AvidAM.pro (for an archive engine)
      ```

      For a split database, type:

      ```
      \Avid_Unity_server_name\workspace_name\AvidWG\AvidWG.pro
      ```

      where Avid_Unity_server_name is the File Manager for Avid Unity MediaNetwork or the System Director for Avid Unity ISIS.

      *You can also browse to the appropriate .pro file and then click Activate. On a cluster you must browse from the network, not from the mount.*
d. The following example shows the pathname on a system that does not have a split database. The system name is wgb-ab.

![Image of Avid Interplay Administrator]

Activate Database

Database (.pro) file to activate: \wgb-ab\WG_Database$\AvidWG\AvidWG.pro

Activate [ ] Load Database on Activation

- Make sure the option “Load Database on Activation” is checked.
- Click Activate.

The upgrade begins. The system displays a dialog box with a progress bar that bounces from side to side while the database is being updated.

*The system will automatically unlock the database if you have Load Database on Activation selected.*

- The database upgrade can take up to 30 minutes, depending on the size of the database. It is important not to interrupt or stop the Interplay Engine or perform a failover during the upgrade process. This could result in problems with the database. To recover from a failed or interrupted upgrade, you need a valid backup of the old database.

2. To verify that you can log onto the database, do the following:
   - Click Menu in the Interplay Administration tool.
   - Click Manage database Roles. The Manage Database Roles view opens.
c. Click the AvidWG icon (AvidAM for archive database).

d. You can tell that you have successfully logged onto the database when the database icon displays a green check mark and the users and roles are displayed as shown in the above illustration.

If you do not deactivate the database before the software upgrade, the database upgrade begins on your first login to the Interplay Engine after you update the software. This occurs the first time you log onto the database with any client (for example, Interplay Access or Interplay Assist). After you type your username and password at the login screen, the system stays at a “Connecting” status while it performs the upgrade. In this case, the system does not display any messages indicating that the upgrade is in progress. Do not exit the application, shut down the system, or fail-over the Interplay Engine while the upgrade is being performed.

Verifying the Upgrade

To verify the upgrade:

1. Navigate to the following location:
   
   C:\Program Files\Avid\Avid Interplay Engine\Logs\Machines\<machine name>

2. Open the NXNServer.log file in Notepad.

3. Search for the text “success”. There should be a message similar to the following:

   Database AvidWG has been successfully updated from version xxxxx to yyyyy

   where xxxxx and yyyyy are the old and new releases, respectively. The message could also say “successfully corrected”. Messages such as the following are part of the upgrade process and can be ignored.

   Can't open file
   'S:\Workgroup_Databases\AvidWG\_Database\Avidxxx.xxx' for reading
**Additional Information for Media Services Transcode Services**

The mixdown mode in the Interplay Transcode service functions differently from the Avid editing application’s mixdown features. For complete information about the Interplay Transcode Mixdown mode, see “Working with the Transcode Service” in the *Avid Interplay Media Services Setup and User’s Guide*.

<table>
<thead>
<tr>
<th><strong>Interplay Transcode Mixdown mode</strong></th>
<th><strong>Avid editing application Mixdown feature</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mixdown type</td>
<td>Mixes down a sequence to audio only, video only, or can include both audio and video in the mixdown.</td>
</tr>
<tr>
<td>Effects</td>
<td>Limited effect support: Video effects—All video effects are supported, except 3-D video effects. Audio plug-in effects are not supported.</td>
</tr>
<tr>
<td>Video support</td>
<td>Additional target resolutions available, including proxies resolutions.</td>
</tr>
<tr>
<td>Audio support</td>
<td>MP2 audio support, 48 kHz only, 16 bits/sample rate for PCM.</td>
</tr>
</tbody>
</table>

**Additional Information for Avid Unity ISIS**

This section includes important information about Avid Unity ISIS.

**Support for ISIS v1.5.x and ISIS v2.0.x on Media Indexer Servers**

Interplay v2.0 supports ISIS v1.5.x, ISIS v2.0.1, ISIS v2.0.3, and ISIS v2.0.4. The following limitations apply for running ISIS client software on a Media Indexer server:

- In an ISIS v2.0.3 or v2.0.4 environment, you can install the ISIS client on a Media Indexer server. If you are upgrading from ISIS v2.0.1, use the following procedure:
  - Uninstall the ISIS v2.0.1 patch
  - Uninstall the ISIS v2.0.1 client
  - Install ISIS v2.0.3 or v2.0.4

See the ISIS v2.0.3 or v2.0.4 Readme for additional information.
• In an ISIS v2.0.1 environment, do the following for each Media Indexer server:
  - Install the ISIS v2.0.1 client.
  - Run an additional patch installer on the server. The installer is available on the ISIS v2.0.1 installer DVD. For additional information, see the Avid Unity ISIS v2.0.1 Readme.

If you need to uninstall the ISIS 2.0.1 client from a Media Indexer server, you must uninstall the patch first. Then uninstall the ISIS client.

• The ISIS v1.5.x client is not supported on Media Indexer servers. In an ISIS v1.5 environment, install the ISIS v1.4 client on your Media Indexer servers. The ISIS v1.4 client installer is available on the ISIS v1.5.x installer DVD. For additional information, see the Avid Unity ISIS v1.5 Readme.

**NIC Drivers, Upgrades, and Mounting Drives**

The following information applies to Avid Unity ISIS:

• Do not install or update Intel NIC drivers on Interplay Engine cluster systems after the cluster setup is complete. Due to the technical aspects of changing resources and devices on a cluster, this can lead to problems with the cluster software and possible data loss.

  The ISIS Readmes recommend that you update the Intel Pro MT/PT drivers on ISIS clients. This statement does not apply to Interplay Engine cluster systems. The Intel drivers on cluster systems do not require updating for this release. Doing so could compromise the integrity of the cluster. In general, do not update the hardware drivers on a cluster system unless instructed to do so by Avid Customer Support.

• The *Avid Unity ISIS Setup Guide* includes an appendix titled “Avid Unity Upgrade Guidelines”. Refer to that guide before you upgrade to ISIS.

• For information on mounting drives, see the *Avid Interplay Software Installation and Configuration* guide.
Additional Information for the Avid Service Framework

Starting at Interplay v1.6.0, the name of the Avid Interplay Framework changed to Avid Service Framework. The names have also changed for the related services. The following table shows the old and new names.

<table>
<thead>
<tr>
<th>Old Framework Name</th>
<th>New Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avid Interplay Framework</td>
<td>Avid Service Framework</td>
</tr>
<tr>
<td>Avid Interplay Diagnostics</td>
<td>Avid Diagnostics</td>
</tr>
<tr>
<td>Avid Interplay Health Monitor</td>
<td>Avid Health Monitor</td>
</tr>
<tr>
<td>Avid Interplay Service Configuration</td>
<td>Avid Service Configuration</td>
</tr>
<tr>
<td>Avid Interplay Workgroup Properties</td>
<td>Avid Workgroup Properties</td>
</tr>
</tbody>
</table>

The installation creates a new folder:

C:\Program Files\Avid Service Framework

You can install the new software over the old software and then delete the old Avid Interplay Framework folder after the installation is complete.

Additional Information for the Service Framework Lookup Service

If you have more than 10 clients in your Avid Service Framework environment (including Avid editing applications, Avid Instinct, and Avid Assist), Avid recommends that you put the Service Framework Lookup Service on a separate server such as a General Purpose Server. See the Interplay Software Installation and Configuration Guide for information on installing the Lookup Service on a separate server.

Additional Installation Information for Media Indexer

See the following topics:

- “Media Indexer Servers and Avid Unity ISIS” on page 28
- “64-Bit Media Indexer File Count and Client Count” on page 29
- “32-Bit Media Indexer File Count and Client Count” on page 29

Media Indexer Servers and Avid Unity ISIS

See “Support for ISIS v1.5.x and ISIS v2.0.x on Media Indexer Servers” on page 26.
64-Bit Media Indexer File Count and Client Count

Interplay v1.4 supports 64-bit Media Indexer servers. The following table shows the supported file count and client count.

<table>
<thead>
<tr>
<th>MI Type</th>
<th>Number of MIs in HAG</th>
<th>Number of MI Clients(^a) in the Interplay environment</th>
<th>Number of files that can be indexed by this MI</th>
</tr>
</thead>
<tbody>
<tr>
<td>HAG member</td>
<td>1 (2 for redundancy)</td>
<td>250</td>
<td>2.4 million</td>
</tr>
</tbody>
</table>

\(^a\) Media Indexer clients include applications that need to locate or create media, such as Avid editing applications, Avid Instinct, Avid Assist, Avid Access, CaptureManager, Low Res Encode, and Interplay Transfer.

Replacing 32-Bit Media Indexers with 64-Bit Media Indexers

See the *Interplay Best Practices Guide* for a procedure to replace 32-bit Media Indexers with 64-bit Media Indexers.

32-Bit Media Indexer File Count and Client Count

For this release, an individual Media Indexer is capable of indexing up to 400k files depending on how you use the Media Indexer in the Interplay environment. The actual number of files depends on the memory used by the Media Indexer monitoring that particular portion of shared storage. Memory usage is affected by the number of files present in the monitored storages and, to a smaller degree, by the length of the storage path. Keeping the maximum number of media files around 500k files and shortening the workspace, sub-folder, and clip names can increase the number of files your Media Indexer can index. However, it is better to monitor the amount of memory used by the Media Indexer and take steps to add additional Media Indexers if memory usage is affected. For information on monitoring the memory used by a Media Indexer, see *Avid Interplay Best Practices*. 
The following table specifies the number of files that different types of Media Indexers can monitor. *Avid Interplay Best Practices* describes the different types of Media Indexers. In this table, the term HAG refers to a High Availability Group.

<table>
<thead>
<tr>
<th>MI Type</th>
<th>Number of MIs in HAG</th>
<th>Number of MI Clients&lt;sup&gt;a&lt;/sup&gt; in the Interplay environment</th>
<th>Requires edits to AvidMI.vmoptions file</th>
<th>Number of files that can be indexed by this MI</th>
</tr>
</thead>
<tbody>
<tr>
<td>HAG member</td>
<td>1</td>
<td>Less than 10</td>
<td>No&lt;sup&gt;b&lt;/sup&gt;</td>
<td>400k</td>
</tr>
<tr>
<td>HAG member</td>
<td>1 or more</td>
<td>Greater than 10, less than 75</td>
<td>No</td>
<td>250k&lt;sup&gt;c&lt;/sup&gt;</td>
</tr>
<tr>
<td>HAG member</td>
<td>2 or more</td>
<td>Greater than 75&lt;sup&gt;d&lt;/sup&gt;</td>
<td>No</td>
<td>250k</td>
</tr>
<tr>
<td>Delegate</td>
<td>NA</td>
<td>NA</td>
<td>No</td>
<td>400k</td>
</tr>
</tbody>
</table>

- Media Indexer clients include applications that need to locate or create media, such as Avid editing applications, Avid Instinct, Avid Assist, Avid Access, CaptureManager, Low Res Encode, and Interplay Transfer.
- Staring at Interplay v1.1.1, you no longer need to edit the vmoptions file.
- Only the leader of the HAG can monitor shared storage files.
- Each individual Media Indexer in the HAG can monitor up to 75 clients. See your Avid representative for the total number of clients that can be supported in an Interplay environment.

**To determine how many files are being monitored by a Media Indexer**

2. Select the system running the Media Indexer and select the Avid Interplay Media Indexer Process.

Open the Avid Interplay Media Indexer section. The Media Files count shows the number of files currently being monitored by this Media Indexer.

Also see “Additional Installation Information for Media Indexer” on page 28.
The following illustration shows two different Media Indexer configurations. See your Avid representative for the maximum number of clients that can be supported by a HAG.

Additional Information for Interplay Media Services v2.0 Upgrade

When upgrading to Interplay Media Services Engine v2.0, you can continue to use Interplay Access v1.6.x and v1.5.x on the client systems. However, you need to install the “Avid Interplay Media Services Client Updater for Access” software. For information, see “Installing Interplay Media Services Client Updater for Interplay Access” in the Interplay Help. You only need to install “Avid Interplay Media Services Client Updater for Access” software on clients in the workgroup that have an Interplay Access prior to v2.0.

If you install or upgrade Interplay Media Services clients with Interplay Access v2.0, you must upgrade the Media Services Engine to v2.0. Therefore, you cannot use Interplay Access v2.0 with an Interplay Media Services Engine prior to v2.0.

Additional Information for ProEncode Upgrades

Bug Number: UDevC00091058. ProEncode does not properly encode master clips with Anystream Agility software. ProEncode installs v1.6 of the Avid QuickTime DNxHD codec, however, Anystream Agility requires a previous version.
Workaround: Contact your technical representative at Anystream and obtain the appropriate versions of codecs to operate with your version of Anystream. Follow their instructions for proper installation and configuration.

Additional Information About the Server Execution User

The Server Execution User is a Windows operating system user account that is used to run the Interplay Engine processes. The Server Execution User is set up the first time that you install the Avid Interplay Engine software and has the following features:

- The account must have local administration rights on the operating system for the Interplay Engine Server (both nodes on a cluster). The Interplay Engine installation software asks you for a user name and password and automatically adds the account to the Administrator Group. Usually this is a domain account that has already been created. The account must have the following local security policy settings:
  - Act as part of the operating system
  - Back up files and directories
  - Restore files and directories
  - Adjust memory quotas for a process
  - Log on as a service
  - Increase scheduling priority

  On a cluster system the account must have these permissions on both nodes. The account must be a local Administrator on both nodes.

  Ideally this should be an account that human users do not use to log onto the system. This will prevent accidental changes to the Server Execution User account during normal administration duties. For example, if someone changes the password by mistake, users may not be able to access the Interplay database.

- An account with an identical user name and password must have read/write access to the Avid Unity workspaces that contain media. You use the Avid Unity ISIS or Avid Unity MediaNetwork Administration tool to create this account.

In order to prevent accidental changes to the Server Execution User account during normal administration duties, Avid recommends that you use a dedicated Windows user account such as "MyDomain\IPEngine" as a Server Execution User and cluster service user. This account should not be used for administrative logins to the Interplay engine hardware.
Changing the Server Execution User in a Clustered Environment

To change the Server Execution User account in a clustered environment:

1. Create the domain user and assign the following local security policies for that user on each node of the cluster:
   - Act as part of the operating system
   - Back up files and directories
   - Restore files and directories
   - Adjust memory quotas for a process
   - Log on as a service
   - Increase scheduling priority
   You can view and set these rights at All Programs > Administrator Tools > Local Security. Click on Local Policies and click on User Rights Assignment. Add the user to each of the above user rights assignments. The user must be a local Admin on both nodes.

2. Make sure that a matching Unity account exists that has read/write access to the Avid Unity workspaces.

3. Shut down the offline node (node two).

4. Run the cluster-aware version of the NXNServerUser.exe tool on the active node (node one).
   Select Custom, follow the on screen prompts, and restart node one.

5. Shut down node one and start up node two.

6. Run the cluster-aware version of the NXNServerUser.exe tool on node two and then restart node two.

7. Start up node one.

For more information on the NXNServerUser.exe tool, see the Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.

Additional Information About Pro Tools

The following information applies to using Pro Tools nd Interplay

- Pro Tools LE is not supported in Interplay.
- Only Pro Tools|HD is supported in the Interplay environment.
- For Interplay and Pro Tools|HD versions, do the following:
  - Go to www.digidesign.com
- Select Support > Support Forum
- Search for Interplay Requirements

For information on using Pro Tools|HD in an Interplay environment, see the *Interplay Best Practices Guide*.

**Video Satellite Support**

Interplay supports the Pro Tools Video Satellite option. Video Satellite allows you to synchronize playback and capture between Pro Tools and either an Avid editing application or MediaStation|PT.

The following Pro Tools releases support the Video Satellite option:
- Pro Tools|HD v8.0cs1 and greater supports the following:
  - Interplay v1.2.3 and greater
  - Avid Media Composer v3.1.2 and greater. NewsCutter and Symphony are not supported
- Pro Tools|HD v7.4 supports the following:
  - Interplay v1.1.4 and greater
  - MediaStation|PT v2.7

*Pro Tools v8.0cs1 does not support MediaStation|PT v2.7.*

For additional information, see the following manual: *Video Satellite Guide Version 8.0*.

**Establishing the First Connection Between Pro Tools and Interplay**

The *Avid Interplay Best Practices* guide describes the software and licenses that are required to use Pro Tools in an Interplay environment. This section contains additional information.

After you use the Interplay Installer DVD to install the Pro Tools Interplay Option and Interplay Access on your Pro Tools system, you must use Interplay Access to establish a connection to the Interplay database that you will be using. This is a one-time requirement that establishes the connection between your Pro Tools system and Interplay. Simply logging on to the Interplay Engine database from Access will establish the connection. Then you can exit Access and start using Pro Tools with Interplay.

*In order to create this initial connection between Access and Interplay, there must be an available license on the Interplay Engine. For example, if you have 10 Access licenses and all 10 are being used, one person must log out of Access while you establish this initial connection.*
Using Antivirus Software in an Interplay Environment

Avid Interplay v2.0 supports the following components of Symantec Endpoint v.11:

- Antivirus
- Antispyware

Interplay has not been qualified with the Firewall component of Symantec Endpoint.

Antivirus software containing autoscanning (real-time scan) features can interfere with the operation of the Interplay Engine. For example, an antivirus program might lock the database files, in which case the Interplay Engine must wait until the file is unlocked. You can install and configure antivirus software on the Interplay Engine, but you need to disable real-time scanning on the Interplay database folders. Any scheduled file scans also need to exclude these folders.

By default, all folders are contained in D:\Workgroup_Databases, which is represented by the hidden administrative share \<Servername>\WG_Database$.

Exclude the D:\Workgroup_Databases folders from any antivirus scanning.

You can run antivirus software on a cluster, if the antivirus software is cluster-aware. For information about cluster-aware versions of antivirus software, contact the antivirus vendor. If you are running antivirus software on a cluster, make sure you exclude these locations from the virus scanning:

- Q:\ (Quorum disk)
- C:\Windows\Cluster
- S:\Workgroup_Databases (database).

File deletion protection utilities also consume system resources and could interfere with the proper operation of the Interplay Engine.

These utilities automatically back up any files that are deleted, even temporary files created and deleted by the Interplay Engine. This consumes a large amount of disk space.

Monitoring the Integration of Journal Files into the Database

The Interplay Engine creates temporary journal files. To avoid potentially serious problems, it is important to monitor the number of journal files that are contained in the _Database folder. For additional information, see the Interplay Software Installation and Configuration Guide.
**Macintosh Installer for Interplay Access Client**

Interplay Access is supported on Mac OS X. On the OS X platform, support is limited to operations relating to file assets (not Avid sequences, clips, and so on). For supported versions, see “Interplay and Supporting Software Components” on page 10. For more information about using Access with Mac OS X, see the *Avid Interplay Access User’s Guide*.

The installer for Mac OS X is located on the Avid Interplay Installer DVD in the following folder:

Installers\JXDK\Mac_Installer

**To run the Macintosh® installer for Interplay Access:**

1. Open the DVD on a Windows system.
2. Copy the installer.zip file to your Macintosh system.
3. Unzip the file and run the installer.

The installation software installs Interplay Access in the following folder:

Applications\Avid\Avid Interplay Access

**Avid Unity MediaNetwork v5.x Support**

Interplay v2.0 supports Avid Unity MediaNetwork v5.x. For information, see the following manuals:

- *Avid Unity Media Engine and Avid MEDIArray XT v5.0 Readme*
- *Avid Unity MediaNetwork Administration Guide*
- *Avid Unity MediaNetwork Client Guide*
- *Avid Unity Media Engine and Avid MEDIArray XT Setup Guide*
- *Avid Unity Media Engine and Avid MEDIArray XT Site Preparation Guide*
- *Avid Unity MediaNetwork Performance Guide*

**Operating Points for Sony XDCAM HD and XDCAM EX**

The Interplay Best Practices Guide describes the end-to-end workflow for Sony XDCAM HD and Sony XDCAM EX Long GOP material. This section lists the operating points that are supported for this Interplay release.
The supported MPEG-2 operating points are based on the Sony XDCAM and XDCAM EX systems. For the end-to-end workflow, Interplay supports 14 operating points that are the basic rates for broadcast applications. Any additional XDCAM or XDCAM EX resolutions are supported in a standalone editor configuration only.

*Interplay supports all 14 operating points. However, not all of the operating points have been qualified on video servers. See “Operating Points Qualified for Omneon Servers” on page 39 and “Operating Points Qualified for AirSpeed Multi Stream” on page 39.*

The following table shows all of the operating points supported by Interplay. Audio is as specified in XDCAM HD/XDCAM EX: PCM uncompressed audio sampled at 48 kHz. Bit widths can be either 16 bit and 24 bit. The audio is encoded as monaural tracks (not stereo pairs).

<table>
<thead>
<tr>
<th>H</th>
<th>V</th>
<th>Interlaced or Progressive</th>
<th>Frame Rate</th>
<th>MPEG Profile and Level</th>
<th>Bit Rate</th>
<th>Sub-sample</th>
<th>Sony Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR 4.2.0</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>18</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR 4.2.0</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>18</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM EX</td>
</tr>
</tbody>
</table>
The following table lists how these operating points are displayed in different applications:

<table>
<thead>
<tr>
<th>Video Format</th>
<th>Frame Rate</th>
<th>Bit Rate</th>
<th>Avid Editing Application Name&lt;sup&gt;a&lt;/sup&gt;</th>
<th>AirSpeed Multi Stream Record Template Name (Service Framework)&lt;sup&gt;b&lt;/sup&gt;</th>
<th>Interplay Media Services Profile Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 1080i</td>
<td>XDCAM-HD 50mbps 1080i 60</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>35</td>
<td>XDCAM HD 35Mbits MXF</td>
<td>XDCAM-HD 35mb 1080i</td>
<td>XDCAM-HD 35 60i</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 1080i</td>
<td>XDCAM-EX 35mbps 1080i 60</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>25</td>
<td>HDV 1080i MXF</td>
<td>HDV 25mb 1080i</td>
<td>HDV 1080i 60</td>
</tr>
<tr>
<td>1080i</td>
<td>59.94</td>
<td>18</td>
<td>XDCAM HD 17.5 Mbits MXF</td>
<td>XDCAM-HD 17.5mb 1080i</td>
<td>XDCAM-HD 17.5 60i</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 1080i</td>
<td>XDCAM-HD 50mbps 1080i 50</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>35</td>
<td>XDCAM HD 35Mbits MXF</td>
<td>XDCAM-HD 35mb 1080i</td>
<td>XDCAM-HD 35 50i</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 1080i</td>
<td>XDCAM-EX 35mbps 1080i 50</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>25</td>
<td>HDV 1080i MXF</td>
<td>HDV 25mb 1080i</td>
<td>HDV 1080i 50</td>
</tr>
<tr>
<td>1080i</td>
<td>50</td>
<td>18</td>
<td>XDCAM HD 17.5Mbits MXF</td>
<td>XDCAM-HD 17.5mb 1080i</td>
<td>XDCAM-HD 17.5 50i</td>
</tr>
<tr>
<td>720p</td>
<td>59.94</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 720p</td>
<td>XDCAM-HD 50mbps 720p 60</td>
</tr>
<tr>
<td>720p</td>
<td>59.94</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 720p</td>
<td>XDCAM-EX 35mbps 720p 50</td>
</tr>
<tr>
<td>720p</td>
<td>50</td>
<td>50</td>
<td>XDCAM HD 50Mbits MXF</td>
<td>XDCAM-HD 50mb 720p</td>
<td>XDCAM-HD 50mbps 720p 50</td>
</tr>
<tr>
<td>720p</td>
<td>50</td>
<td>35</td>
<td>XDCAM EX 35Mbits MXF</td>
<td>XDCAM-EX 35mb 720p</td>
<td>XDCAM-EX 35mbps 720p 50</td>
</tr>
</tbody>
</table>

<sup>a</sup> For Avid editing applications, the video format and rate are determined by the project settings.

<sup>b</sup> For AirSpeed Multi Stream record templates, the frame rate is determined by the channel configuration.
### Operating Points Qualified for Omneon Servers

The following table lists the operating points qualified for Omneon servers in an Interplay environment.

<table>
<thead>
<tr>
<th>H</th>
<th>V</th>
<th>Interlaced or Progressive</th>
<th>Frame Rate</th>
<th>MPEG Profile and Level</th>
<th>Bit Rate</th>
<th>Sub-sample</th>
<th>Sony Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
</tbody>
</table>

### Operating Points Qualified for AirSpeed Multi Stream

The following table lists the operating points qualified for AirSpeed Multi Stream in an Interplay environment.

<table>
<thead>
<tr>
<th>H</th>
<th>V</th>
<th>Interlaced or Progressive</th>
<th>Frame Rate</th>
<th>MPEG Profile and Level</th>
<th>Bit Rate</th>
<th>Sub-sample</th>
<th>Sony Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR 4.2.0</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>59.94</td>
<td>MP@HL</td>
<td>18</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1920</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>35</td>
<td>VBR 4.2.0</td>
<td>XDCAM EX</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@H-14</td>
<td>25</td>
<td>CBR 4.2.0</td>
<td>XDCAM HD &amp; EX (HDV)</td>
</tr>
<tr>
<td>1440</td>
<td>1080</td>
<td>Interlaced</td>
<td>50</td>
<td>MP@HL</td>
<td>18</td>
<td>VBR 4.2.0</td>
<td>XDCAM HD</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>59.94</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
<tr>
<td>1280</td>
<td>720</td>
<td>progressive</td>
<td>50</td>
<td>422P@HL</td>
<td>50</td>
<td>CBR 4.2.2</td>
<td>XDCAM HD Phase III</td>
</tr>
</tbody>
</table>
The following documents describe how to use Avid Interplay. All of these documents are available on the Avid Knowledge Base.

- **Avid Interplay Best Practices** — provides an overview of the major Interplay components, shows sample configuration diagrams, and describes several of the key features, such as setting up a user database and using the Avid Interplay Archive Engine.


- **Avid Interplay Engine Failover Guide** — describes how to set up a cluster configuration for the Avid Interplay Engine and the Avid Interplay Archive engine.

- **Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide** — describes how to administer your Avid Interplay Engine or Avid Interplay Archive Engine database.

- **Avid Interplay Access User's Guide** — describes how to use Interplay Access; a key interface between the Avid editing applications and the features available on the Avid Interplay Engine.

- **Avid Interplay Assist User’s Guide** — describes how to use Interplay Assist for logging, archiving, and sending to Playback material in an Interplay environment.


- **Avid CaptureManager User’s Guide** — describes how to use CaptureManager in a newsroom environment to coordinate video feeds, schedule feed captures at both high and low resolutions, and record late breaking events instantly.

- **Avid CaptureManager Installation and Configuration Guide** — describes how to set up and configure CaptureManager.

- **Avid Low Res Encode Setup and Configuration** — describes how to set up and configure an Avid Low Res Encode system. Includes information on updating the bootset, root disk image, and configuring a Low Res Encode system to work with CaptureManager.

- **Avid Interplay Transfer Setup and User’s Guide** — describes how to use Interplay Transfer to transfer media to and from another workgroup, send finished sequences to a configured playback device, ingest media from a configured ingest device, and perform standalone transfers between workstations.

- **Avid Interplay Media Services Setup and User’s Guide** — Avid Interplay Media Services lets you control and automate Transcode, Archive, and ProEncode services.
Documentation Changes

See the following topics:
- “Improving Search Response Time” on page 41
- “Clip and Video ID Naming Conventions” on page 41
- “Archive Engine Installation” on page 41

Improving Search Response Time

Avid Interplay includes a powerful, customizable search. If you are working in a facility with a large database, you can speed up the search process by specifying a particular folder as the search root and by using attributes. For example, by using the Time attribute, you can limit your search to clips modified within the last 24 hours, the last 7 days, and other time periods.

Even if you only change the search root, or search by a single attribute, you can dramatically improve the response time. For additional information, see the Interplay Best Practices Guide.

Clip and Video ID Naming Conventions

The following naming conventions apply to clip names and Video IDs:
- Clip names should not contain the following characters: *, ?, :, /, and \
- Video IDs should not contain spaces or the following characters: *, ?, :, /, and \\

Earlier versions of this Readme incorrectly stated that Clip names could not contain spaces.

Archive Engine Installation

Bug Number: UDevC00081128. When you perform a new Archive Engine installation, you must load the archive license key before you create the database on an Interplay Archive Engine. Unlike the Interplay Engine, the Archive Engine database does not contain a default license. If you attempt to create the database before you load the license, the Archive Engine software will not create the default archive folder and the folders in the tree view will not display with the correct (brown box) icons.
The archive engine installation is very similar to the Interplay Engine installation. The following are the main differences:

- It is not necessary to split the database because it is not possible to archive file assets
- The database is called AvidAM
- There is no temporary license key. On the Interplay Engine it is possible to connect one Access client to the engine when no permanent license is loaded. This is not possible on the Archive Engine. It is necessary to load a license before you are able to connect with Access. It is also necessary to load the license before you create the database as described above.
- The AvidAM database has less pre-defined folders than the AvidWG database

**New for Interplay v2.0**

This section lists new features for Interplay v2.0. See the Interplay Help or the appropriate user’s guide for complete descriptions.

**Support for 720p Proxy Media**

Interplay v2.0 supports a MultiRez workflow for 720p high res and low-res proxy media. You typically capture 720p high res material and then transcode to 720p proxy.

In a MultiRez workflow a media manager or Interplay administrator archives most of the high-res material to a robotic tape library and maintains a low-res version online. For example, a sports station may capture high res media for entire sporting events with a duration of three or four hours each. After archiving, the media manager deletes the online high-res material and maintains the low-res material online. The low-res material is stored on line partly to allow editors to work with it and partly as a reference for the material in the archive. After an editor cuts some of the low res material into a sequence, he or she can perform a partial restore and restore just the amount of high res material that they need for the sequence.

See the *Interplay Best Practices Guide* for a 720p proxy workflow.

**Interplay Access 2.0**

Interplay Access version 2.0 includes the following new features:

- You can browse the Interplay database and play clips on a computer in your local-area network (LAN) or from anywhere in a wide-area network (WAN) through the Interplay Stream Server. The computer on which you are running Interplay Access 2.0 does not need ISIS or MediaNetwork client software and it does not need to be connected to an Avid-certified network infrastructure.
**New for Interplay v2.0**

- You can use Interplay Access 2.0 to create locators on clips and shotlists. Avid editors can view these locators, and Access users can view locators created by Interplay Assist or Avid editors.
- You can mark In and Out points to create subclips and shotlists, and check them into the Interplay database so they can be shared by Avid editors and other Interplay users.
- The Delete dialog box is now displayed whenever you select a file asset for deletion from the Interplay Engine, and includes an option for deleting folders. Also, in the Delete dialog box, the option “Delete Only Media Created with This Clip” is now selected by default.

**LAN/WAN Workflow Support Services**

The following new services support workflows for LAN/WAN browsing and collaboration in an Interplay environment:

- **Interplay Stream Publish Service.** The Avid Interplay Stream Publish service provider is an Interplay Media Services service that creates QuickTime reference movies that refer to MPEG-4 video files and MPEG1 Level 2 audio files. After the service creates a QuickTime reference movie for a selected asset, it checks the file into the Interplay database as part of the selected asset’s metadata. You can then play the asset in the Interplay Access 2.0.
- **Interplay Stream Server.** An SR2500 Intel server configured as a streaming server. See the *Interplay Software Installation and Configuration Guide* or the Interplay Help for information on configuring an Interplay Stream server.
- **Workflow Engine and Auto Publish flow charts.** The Auto Publish workflow is supported by three flow charts in the Avid Interplay Workflow Engine. The Workflow Engine provides a tool for automating the stream publish workflows, using Auto Publish with the Interplay Stream Publish service. The automation process creates or publishes QuickTime reference movies. The Workflow Engine uses flow charts with defined tasks that execute appropriate actions. Avid provides pre-configured flow charts that consist of triggers, actions, and flows to complete a particular job.
- **Mixdown/Transcode Service.** The Interplay Transcode service can mixdown the audio and video during the transcode process. You can set up an Interplay Transcode profile in the Avid Interplay Media Services and Transfer Status window for the type of mixdown you want to perform. Then you can use Interplay Access or an Avid editing system to select the items to transcode and select the profile to use for the transcode and mixdown.
- **Interplay Delivery Service.** Avid Interplay Delivery is a service that is part of Interplay Media Services. The Delivery service lets you perform workgroup-to-workgroup transfers of shotlist, subclips, master clips, and cuts only sequences, and their media files. You can use a Delivery profile to choose to only transfer the portion of the media that is used in a subclip.
Additional Interplay Media Services Features

Avid Interplay Media Services v2.0 includes the following new features:

• Copy service: You can use the Copy service to copy assets (metadata) and their media files from one workgroup to another. For example, if your facility uses a specified workgroup for low-resolution media, you might need to copy clips and their low-resolution media files to the low-resolution workgroup and copy them back again.

Copying to a workgroup uses an Avid Interplay Media Services service (the Copy service) and its related provider. As with other services, you can create a profile for automating workflows. You can also use the auto-copy feature and profiles to set a folder for automatically copying the assets placed in it or to replicate an entire database for backup.

• Interplay Media Services Client Updater: You can update your Interplay Media Services engine to v2.0 and continue to use Interplay Access v1.6.x or v1.5.x in your workgroup. This allows you to use older editors that support Interplay v1.5.x and v1.6.x.

• Automatically purging jobs: You can now configure the Media Services engine to automatically purge specific types of jobs. This can improve the performance of the Avid Interplay Media Services and Transfer Status tool.

• Preserving Media Services profiles: Previously, when you upgraded a service you had to recreate the profiles for that service. This version of Media Services lets you keep your profiles. However, you will need to check the profiles to verify the values are correct.

• Modifying multiple profiles at the same time. This feature is useful after you upgrade a service provider and you need to modify your existing profiles to correct any values that are not supported with the new version of the service provider. In the Parameters area of the profile, a caution icon indicates which profile settings require attention. This feature is also useful for setting the parameters of multiple profiles after installing new Media Services services.

• The *Interplay Media Services Setup and User’s Guide* now contains descriptions and solutions for Archive and Restore error messages.

• Mix and Match. Avid editing applications allow you to work with clips of any frame rate or field motion type (interlaced or progressive) in a project. Clips that do not match the frame rate or field motion type of the project are known as mixed-rate clips. Avid Interplay now supports working with mixed-rate clips and sequences with mixed-rate clips.

See the *Interplay Media Services Setup and User’s Guide* for additional information.
Interplay Administrator v2.0

The Editor Database Settings view has been renamed and reorganized. The new name is Application Database Settings and it includes two tabs.

- Editing Settings tab. This tab includes settings that were included in the Editor Database Settings view.
- Application Defaults tab. This tab includes the following new settings:
  - Setting Audio Mixing Defaults for Access and Assist. For Interplay Access, the settings apply to the Audio Mixer controls, which let you enable and mute tracks and adjust volume. For Interplay Assist, the settings apply to the Local Audio Mixing controls, which let you edit audio settings for clips or subclips that you load in the Monitor.
  - Setting the Shotlist Start Timecode for Interplay Access and Interplay Assist. An administrator can set the default starting timecode for shotlists that are created in Interplay Access or Interplay Assist. The default starting timecode for shotlists is 01;00;00;00 (drop frame) or 01:00:00:00 (non-drop frame). For example, you can use this setting to change the starting timecode hour from 01 to 00.
  - Setting an Automatic Timeout for Interplay Assist and Avid Instinct. An Interplay administrator has the option of letting Interplay Assist and Avid Instinct automatically time out after a specified period of inactivity. This feature helps in license management, because it enables an unused license to be freed up without the administrator manually finding and closing inactive applications on user desktops.

The documentation for Instinct/Assist User Settings includes new information about settings that affect users of Avid editing applications:

- In the Instinct/Assist User Settings view, you can set permissions for various editing functions on the group or user level. These settings apply to all folders in the database, so in some cases the settings apply to users on Avid editing systems (NewsCutter, Media Composer, and Symphony) who are checking Avid assets into the Interplay database. For additional information, see the Interplay Help or the Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.

Interplay Assist v2.0

Interplay Assist v2.0 includes the following new features:

- Ability to set an automatic timeout. This feature was added in Interplay Assist v1.6.2, but required the administrator to create a custom property. The Interplay Administrator now includes a setting in the Application Defaults tab of the Application Database Settings view.
- Display of colored text for file and folder names, if they are set in Interplay Access.
• Ability to navigate to a folder that contains a selected asset by selecting the context menu command “Open Enclosing Folder.”

• Support for MPEG-4 video and four compressed MPEG2 Layer 1 audio tracks. These formats are used as proxy media in an Interplay streaming workflow.

• Local Audio Mixing Controls, which let you edit audio settings for clips or subclips that you load in the Monitor.

For more information about these features, see the *Avid Interplay Assist User’s Guide* or the Interplay Assist Help.

**Interplay Window (Media Composer v4.0, Symphony v4.0, NewsCutter v8.0)**

The Interplay Window includes the following new features:

• Display of colored text for file and folder names, if they are set in Interplay Access.

• Ability to navigate to a folder that contains a selected asset by selecting the context menu command “Open Enclosing Folder.”

• Creating a duplicate of an Avid asset when you drag it from the Interplay Window to a local bin.

For more information about these features, see the documentation or Help for your Avid editing application.

**Limitations**

This section describes existing limitations.

**Problems Performing a Clean Install of Interplay Transfer v2.0**

UDevC00130876: There is a problem with the Interplay Transfer installer. It does not install Microsoft .NET 1.1 which is a required component for Interplay Transfer.

Upgrades will not have a problem since .NET 1.1 will still be present from the previous install. However, when performing a clean install, you will need to download and install .NET 1.1 before you install Interplay Transfer.

**To download the NET 1.1 installer:**

1. Navigate to Microsoft’s download page:
   
   http://www.microsoft.com/downloads/

2. In the “Top Downloads for” area of the page, select Development Resources from the menu and clock Go.
3. The Popular Downloads list shows several .NET items. Select the following:
   .NET Framework Version 1.1 Redistributable Package
4. Locate the dotnetfx.exe section and click Download.
5. After the download completes, run the dotnetfx.exe installer and follow the system, prompts.
6. Now you can install Interplay Transfer. Use the Interplay Transfer installer on the Interplay Installation DVD.

**New Limitations for Interplay v2.0**

➤ **Bug Number:** UDevC00128577. Partial Restore and Partial Delivery will not work with media created by the following versions of the Avid editing applications:
   - Media Composer v2.6.x and earlier
   - Symphony v1.6.x and earlier
   - NewsCutter v6.6.x and earlier

   **Workaround:** Use full restore or full delivery for this media.

➤ **Bug Number:** UDevC00126315. Selecting Help > Documentation Website on Server does not open the Interplay User Assistance Center. Workaround: Select this command in Interplay Access or type http://Interplay_Engine_name.

➤ **Bug Number:** UDevC00129418. Extended searching for published media ("Streamable media is published") is currently designed to return only master clips and to filter out other media types. For example, subclips created from published clips are not displayed, even if you include the search criteria "Type is subclip."

➤ **Bug Number:** UDevC00130229. If you double-click a published clip, the clip loads in the Monitor but does not play. Workaround: Use the transport controls to play the clip.

➤ **Bug Number:** UDevC00130269. Setting many locators on a large shotlist can create FileNotFoundException exceptions in workgroup.log.

➤ **Bug Number:** UDevC00130335. The shortcut for deleting locators (Ctrl+Shift+Delete in Windows, or Shift+Command+Delete in Mac OSX) does not work when the keyboard focus is on the Monitor. Workaround: Click outside the Monitor and try the operation again.

➤ **Bug Number:** UDevC00130501. Versions of Interplay Access earlier than V2.0 might not display timecode for locators in a clip that is checked into an Interplay V2.0 database. For example, add locators to a clip in Media Composer V4.0, Symphony V4.0, or NewsCutter
V8.0, and check the clip into an Interplay v2.0 engine. Open the clip in a version of Interplay Access earlier than V2.0 and click the Frame Locators tab of the Object Inspector. No timecode is displayed for the locators. Workaround: Check the clip in again and the timecodes should be displayed.

➤ **Bug Number:** UDevC00130628. Versions of Interplay Access earlier than V2.0 might display duplicate locators for a clip that is checked into an Interplay V2.0 database.

➤ **Bug Number:** UDevC00130711. Applying settings for Pro Tools Import on folders other than the root results in an error message. Workaround: Apply the settings to the database root and the settings are correctly inherited by subfolders. If desired, you can change the database to the default settings and apply different settings to a subfolder.

➤ **Bug Number:** UDevC00130850. Opening a shotlist in Media Composer that was created in Interplay Access from subclips created in Media Composer or Interplay Assist results in an exception (Sequence refers to non-existent track in clip). This limitation also applies to Symphony V4.0 and NewsCutter V8.0. Workaround: Create the subclip for the shotlist in Access.

➤ **Bug Number:** UDevC00130852. An audio-only clip in Access can be used a subclip or as the first shot in a shotlist only if the In mark is on the first frame.

➤ **Bug Number:** UDevC00128569. You cannot use the Update from Media Indexer command to update the media status for a remote workgroup. You receive an error message that the user is not connected to the Lookup service for that workgroup. Workaround: Install the Avid Framework Service on the Interplay Access client. Open the Avid Framework Service Workgroup Properties and configure the remote workgroup's lookup service in the Workgroup Properties > Lookup tab.

➤ **Bug Number:** UDevC00130379. Clips that are transcoded to MPEG-4 video and published, but do not include audio, do not play back in the Monitor. A clip might play for a few seconds and then stop. Workaround: If a clip contains audio, transcode and publish both the video and the audio.

➤ **Bug Number:** no number. Interplay v2.0 does not support locators created in Avid Airspeed.

**Limitations on Locator Text**

The following limitations apply:

- (Assist) Interplay Assist lets you enter locator text that contains up to 32,000 characters. This text can be displayed in Interplay Assist and Interplay Access. Clips that include locator text longer than 32,000 characters cannot be checked into Interplay.
• (Assist and Avid editing applications): Locator text in Avid editing applications is limited to 1,024 characters. If a user on an Avid editing system checks out a clip with locator text longer than 1,024 characters, only 1,024 characters are displayed and the rest of the text is cut off.

**Long GOP (Assist and Instinct)**

➤ **Bug Number:** UDevC00123047. If your workflow includes sending Long GOP (XDCAM HD or XDCAM EX) media to playback, you need to do the following:

1. Log in to the Client Manager (ISIS) or Connection Manager (MediaNetwork) with an account that has write access to one or more workspaces.

2. In the Client Manager or Connection Manager, mount at least one of the workspaces to which you have write access as a lettered drive. (All MediaNetwork workspaces are mounted as lettered drives. For ISIS workspaces, you need to specify lettered drives.)

When you send to playback, the application searches the workspaces to which you have write access and writes a temporary file to a Temp folder at the top level of the workspace with the most free storage space. If you do not have workspaces mounted as lettered drives, you get an error message “Unable to find a shared storage volume for media transfer.”

**Media Indexer Upgrade Installation**

➤ **Bug Number:** UDevC00121434. 64-Bit Media Indexer Install: Updating the 64-Bit Media Indexer software does not remove the previous version.

**Workaround:** Before upgrading a 64-Bit Media Indexer, use the Add/Remove Programs application in the Control Panel to uninstall the previous version. If you have more than one version installed, uninstall all versions of the Media Indexer and then install the new version.

**AVC-Intra Resolution**

Interplay v2.0 supports editing and playback of P2 media encoded using the Panasonic P2 AVC-Intra codec. You can import, playback, transcode, and consolidate AVC-Intra resolutions. The following limitations apply:

• You cannot create AVC-Intra material using transcode features.

• You must turn Dynamic Relink off while importing AVC-Intra material. Once you import the AVC-Intra material you can start using Dynamic Relink with it.

• AVC Intra resolutions now display in the Dynamic Relink settings.

• UDevC00116685 You cannot export a QuickTime movie using the Same as Source option with AVC-Intra material
• ProEncode does not work with AVC-Intra material for this release. This is related to the QuickTime problem because ProEncode creates a QuickTime Reference movie as part of its process.

Relinking Offline Media for Precomputes

➤ **Bug Number:** UDevC00116797. The term precomputes refers to the media files created when you render an effect or title. The precomputes associated with a sequence can appear offline in the following cases:
• After restoring the sequence from an archive
• After moving the media files associated with a sequence to a different workspace

To refresh the links for offline precomputes:
1. Select Reset Offline Info from the Bin Fast menu
   The system refreshes the links to all of the precomputes in the project. If a sequence is loaded in the monitor, the system automatically reloads the sequence.

Interplay Access and Force-Delete Locked Media

➤ **Bug Number:** UDevC00117091. The “Force-delete locked media” option was introduced in Interplay Access version 1.4.2. If you connect Access to an Interplay Engine running a version earlier than 1.4.2, the option is visible in the Delete dialog box but does not work. If you select the option and attempt to delete files, the files are not deleted and “access denied” is displayed in the Delete Summary dialog box.

**Workaround:** In the Avid editing system, locate the clip you want to delete in a bin. If it is not in a bin, drag and drop it from the Interplay Window. Select the clip in the bin and then select Clip > Unlock Bin Selection. You should then be able to delete the clip and the media from Interplay Access.

Changing Source Information for a Clip in Interplay

There are two types of source information that usually should not be changed for a master clip in an Interplay environment:
• Source tape name
• Timecode format (changing between drop frame and non-drop frame)

The tape name and timecode format are part of the source information for a clip and changing them may cause the clip to become offline whenever Dynamic Relink is activated. Once this happens, the relation of the clip to its media can be permanently lost.
If it is necessary to change the tape name or timecode format for a master clip in an Interplay environment, use the procedure described in this section.

You only need to perform this procedure if both of the following statements apply:

- If your site uses Dynamic Relink. If your site does not use Dynamic Relink there is no need to perform the procedure.
- If you are associating a master clip with a different tape name or timecode format. If you are simply changing the name of an existing tape you don’t have to perform the procedure.

**To change the tape name or timecode format for a clip in an Interplay environment:**

1. Disable Dynamic Relink. See the Avid editing application Help or the Interplay Help for information on Dynamic Relink.

2. Right-click the master clip in the bin and select Modify > Set Source.

3. To change the tape name, do the following:
   a. Select Set Source from the Modify dialog box popup menu. The Select Tape dialog box opens.
   b. Change the source tape name. Use an existing tape name or create a new one.

4. To change the timecode format to drop or non-drop frame, do the following:
   a. Select “Set Timecode Drop/Non-drop” from the Modify dialog box popup menu.
   b. Select the format and click OK.

*The media will remain online at this point because Dynamic Relink is turned off.*

5. Consolidate the clip to generate new media that will be associated with the newly selected tape name. Use the following options:
   - Uncheck “Skip media files already on the target drive”
   - (Option) check “Delete original media files when done”
   - Use the default settings for all other conversion parameters

The system generates new media files that will reference the correct tape name or timecode format. See the Avid editing application Help for additional information on the Consolidate command.

6. Re-enable Dynamic Relink.

7. Double-click the clip in the bin to trigger the relink. The media will be online and linked correctly to the adjusted tape name.
ISIS v2.0, ISIS v1.5.1 and Media Indexer Servers

See “Support for ISIS v1.5.x and ISIS v2.0.x on Media Indexer Servers” on page 26.

Automatic Reservation Limitations

You can set the value for automatic reservations in the Avid Interplay Administration tool using the Editor Database Settings view. This section specifies the behavior of automatic reservations for this release.

Automatic reservations now work correctly for the following situations:

- If you duplicate metadata (such as a master clip or sequence) in the Avid editor application bin and then check it into Interplay.
- If you create new metadata such as a new sequence, subclip, or title and check it into Interplay.
- If you create new media in a bin and then check it in. This includes operations such as import, capture, and consolidate.

Write Permission in Interplay Applications

➤ **Bug Number:** UDevC00099462. Interplay Access has different rules for allowing a user to modify a clip in a folder that they do not have write permission to. The rules are different from Assist, Instinct, and the Interplay Window. For this discussion, assume the following:

- The user has been given write access in the Instinct/Assist User Settings window of the Interplay Administrator tool. For example, the user is allowed to modify locators or to modify column properties.
- The clip exists in at least one folder that the user has write permission to.

In Access, the system checks whether the user has write permission on the current folder. If the user does not have write permission to this folder, the user cannot modify the asset in that folder.

In Assist, Instinct, and the Interplay Window, the system checks whether the user has write permission to any folder that contains the clip. As long as the user has write permission to at least one folder that contains the clip, the user can modify that clip in any folder.

Viewing Referenced Assets in Assist

In Assist, you cannot view the master clip associated with a subclip in the same folder. In the Avid editing application and in Access, you have the option of displaying referenced assets in the same bin or folder. You do not have this option in Assist. This is not usually a
problem. For example, if you are working with a subclip in Assist, you usually have no need to see the master clip it was created from. You may encounter this problem if you move subclips and their associated masterclips in and out of folders in Access. Masterclips will not be visible in Assist if that folder once held the same clips as referenced assets. Once a subclip goes into an Assist folder, the display for the referenced asset is turned off. You may also receive a message telling you the clip already exists in that folder.

To view a referenced clip in Assist:

- In the Avid editing application, check the referenced master clip(s) into Interplay, using the "Show Reference Clips" option in the editing application bin.
  
  Now the master clip is an unreferenced asset and an Assist user can view the master clip.

General

See the following ReadMe files for additional information:

- Interplay Engine, Interplay Archive, and Interplay Access
- Avid Service Framework
- Avid CaptureManager
- Interplay Transfer
- Interplay Media Services
- Interplay Assist
- Avid Instinct

➤ Bug Number: UDevC00121515. Low-Res Encoder and Avid editing systems: If you consolidate an MPEG 2 clip captured through the Avid Low Res Encoder, or a sequence that uses the clip, you might get an error “Range specified for Dup is outside range of component.” This occurs only if you use the first 2:10 of the clip.
  
  Workaround: Consolidate the high-res version of the clip.

➤ Bug Number: UDevC00106180. Interplay and Avid editing systems: If Auto-reservation is enabled (in the Interplay Administrator), but reservations are deactivated for a particular folder ("Allow creation of reservations" is deselected in the Security options for the folder in Interplay Access), a user on an Avid editing system can check an asset into that folder but there is no message to warn the user that the asset is checked in without a reservation. This could be a problem if the user assumes auto-reservation is enabled for the folder but in fact the content of that folder is not protected.
➤ **Bug Number:** UDevC00119218. Partial restore is not supported when OMF media or MXF media are transcoded using an Avid editing application. A full restore is performed instead.

➤ **Bug Number:** UDevC00113195. Media Indexer Quarantine: If you use Windows Explorer to copy a large MXF media file (larger than 1 GB) from an external drive to shared storage, the Media Indexer may quarantine the file before it is finished copying. The problem occurs if the Media Indexer starts scanning the drive before the copy operation is completed.

**Workaround:** When copying large MXF files to shared storage, do not copy the file directly to the Avid MediaFiles\MXF folder. Copy the file to another folder on the workspace (such as the Creating subfolder within the Avid MediaFiles folder) and then move the file into the MXF folder. This way the copy operation will be fast enough so that the Media Indexer won’t move the file into the Quarantine folder.

➤ **Bug Number:** UDevC00113305. Media Indexer: If you try to use Windows Explorer to copy media from a network share or any folder not indexed by Media Indexer to an indexed folder (OMFI MediaFiles or Avid MediaFiles), you might get an Access Denied message.

**Workaround:** Copy the media files to the Creating subfolder (within the OMFI MediaFiles or Avid MediaFiles folder) and then move them to the media folder.

Also, if you were able to copy media to an indexed folder and then need to move or delete the files, or if they are quarantined and need to be deleted, you might get an Access Denied message. Workaround: Wait a few minutes and try the operation again.

➤ **Bug Number:** UDevC00121042. Assist: If you load a clip that is being captured (an Edit-While-Capture or EWC clip), and then modify the Audio/Video Monitoring preferences and click OK, the preferences do not persist. If you then load a completed clip, you can scrub through the clip but you cannot play it, and you need to relaunch the application.

**Workaround:** Change the Audio/Video Monitoring Preferences before loading the EWC clip. This problem does not occur if you change the Audio/Video Monitoring preferences while the EWC clip is playing.

➤ **Bug Number:** UDevC00120939. Interplay and Avid editing application): If the working resolution is not set in the Instinct/Assist User Settings in the Interplay Administrator, the following error message appears when you log in to Interplay: “No Working Video Resolution Set, Dynamic Relink will be disabled.” This message is incorrect, because this setting does not apply to an Avid editing application.
Workaround: Close the error message and continue working. To avoid display of the error message, set the working resolution in the Instinct/Assist User Settings in the Interplay Administrator.

➤ **Bug Number:** UDevC00118842. Edit while capture with AirSpeed Multi-Stream. If you play a currently ingesting HD clip in an editing application, the audio might drop out while the video continues to play. When the dropout occurs depends on the compression of the clip, but it can be up to a minute after the live feed begins.

Workaround: Precut the clip to the head frame in the editing application and restart play.

➤ **Bug Number:** UDevC00121373. Interplay Assist and Avid editing applications: In Assist, when you apply a locator to an audio-only sequence, or to a sequence without a V1 track, the locator appears on an empty V1 track in the Avid editing application timeline.

➤ **Bug Number:** UDevC00116644. Interplay Assist and Avid Instinct: If you start the application shortly after quitting, you might see an "Unknown Exception" error message.

Workaround: Wait 10 seconds and log in again. If you still see the error message, close the application and relaunch it.

➤ **Bug Number:** UDevC00118600. Interplay Assist, Avid Instinct, Interplay Window: If you create a subclip from a master clip with the resolution displayed as "XDCam HD 50mb 1080i 60," the resolution of the subclip will be displayed in the Current Video Resolution column as "XDCam HD 50mb."

Workaround: Assist and Instinct: If you need to determine the complete resolution for the subclip, move the mouse pointer over the title of the clip (above the monitor) and the complete resolution is displayed.

➤ **Bug Number:** UDevC00106005. FTP ingest of 1080p 23.97 proxy files fail to import when dragging and dropping the proxy only clip to a bin from FTPClipList.

Workaround: You can use a firewire connection to import the 1080p 23.97 proxy file.

➤ **Bug Number:** UDevC00115806. Assist Locators: You can add multiple locators to the same frame in Assist but you cannot view more than one locator in the Avid editing application timeline.

Workaround: In the editor, click the Locator and select the Locator window from the Tools menu.

➤ **Bug Number:** UDevC00115457. Assist – You cannot use Assist to play back a sequence with more than 16 tracks.
**Workaround:** Select Preferences > Audio/Video Monitoring and turn off the additional tracks.

➤ **Bug Number:** UDevC00115102. XDCAM EX and FTP Clip List – Ingest via FTPClip List does not work correctly for XDCAM 720p 5994 EX 35Mbit.

**Workaround:** Imports via 1394 firewire works correctly. Also, 720p 5994 50 Mbit works correctly for FTPClip List

➤ **Bug Number:** UDevC00113396. (Editors) If you use the Move Media Service to move clips from one workspace to another, the Drive column in an Avid editing system bin does not always show the correct drive. Sometimes loading the clip results in a DISK FILE NOT FOUND screen, and the Reveal File command does not show the file. Sometimes the clip loads and plays back correctly, and the Reveal File command shows the file on the new drive, but the bin column still shows the original drive.

➤ **Bug Number:** UDevC00116120. Limitation: Dual ingest with 720p and Avid Low Res Encode is not supported for Beta 2 because of timecode issues. The recording either fails or the resulting media files have different timecode values.

➤ **Bug Number:** UDevC00115102. Ingest from XDCAM EX devices is not supported for this Beta release.

➤ **Bug Number:** UDevC00110280. On the Media Indexer server, if you change the language locale option after you install Media Indexer and then restart the server, the MI service might stop and restart constantly. Similarly, if you selected “Install files for East Asian Languages” in the Languages tab of the Windows Regional and Language Options control panel and then reinstall or update Media Indexer with an English locale selected, the MI service might stop and restart constantly.

**Workaround:** Change the language locale before you install or update Media Indexer. If you are going to use an English locale, deselect “Install files for East Asian Languages” before you install or update Media Indexer.

➤ **Bug Number:** UDevC00113671. If you increase the duration of a currently ingesting AirSpeed Multi Stream clip in Capture Manager™, you might not be able to play the clip beyond the original duration and you might see an error message.

**Workaround:** Make sure you set the initial duration of the clip to be longer than what you need.

➤ **Bug Number:** UDevC00111283. When you import P2 media from a virtual volume, the system adds a duplicate storage path for the Media Indexer. The additional path is visible in the Service Framework Service Configuration tool.
**Workaround**: Open the Service Configuration tool, locate the local Media Indexer on the editing system, and remove the extra storage location.

➤ **Bug Number**: UDevC00116123. In Assist or Instinct, currently ingesting media from IPV playback may stop after a couple a minutes or longer depending on the length of the ingest.

➤ **Bug Number**: UDevC00115587. When archiving a folder which contains a sequence and it's relatives, the job will display the sequence and each relatives as a separate transaction in the Job Status window.

➤ **Bug Number**: UDevC00111924. In Assist or Instinct, you may get play frame errors while scrubbing currently ingesting media from Avid Low Res Encode.

➤ **Bug Number**: UDevC00105694. Custom fields from Assist do not appear in the editor bin.

➤ **Bug Number**: UDevC00112360. You may encounter FILE_OTHER errors with dynamic relink set to low res media captured by Avid Low Res Encode.

**Workaround**: Force quit the application using the Task Manager.

➤ **Bug Number**: UDevC00107298. You may encounter "DecompStream::FillBuffer Invalid Stream" errors in the editor with currently ingesting media from Avid Low Res Encode on Avid Unity MediaNetwork.

➤ **Bug Number**: UDevC00108356. Avid Low Res Encode captures may fail with "clip is empty" error when the scene change option is enabled.

➤ **Bug Number**: UDevC00117478. The Archive Engine will display the incorrect size of an asset.

➤ **Bug Number**: UDevC00117457. After a dual capture with Avid Low Res Encode, the low res video may be out of sync with the low res audio.

**Workaround**: Use the low-res video and the high res audio for dual captures.

➤ **Bug Number**: UDevC00116929. In the editor, you may encounter an error while trying to scrub or playback currently ingesting media from Avid Low Res Encode.

➤ **Bug Number**: UDevC00117286. If you import media from a P2 drive and create a sequence with the media that is still on the drive, performing a Send to Playback operation consolidates the media to an incorrect drive.

**Workaround**: Consolidate the media from the P2 drive before you send to playback.
Bug Number: UDevC00113856. If you check in a sequence that uses master clips that are currently being ingested, then open Interplay Access, the sequence appears as partially online (blue), although the sequence is actually online. This also applies to .transfer sequences.

Workaround: To update the status, select the items, right-click, and select Update Status from Media Indexer.

Bug Number: UDevC00112191. Archive Restore: “No resolution found” errors after performing a Restore from Archive operation.

Workaround: If you receive this type of error when performing a restore, right-click the clip and select Update Status from Media Indexer, and perform the restore operation again.

Bug Number: UDevC00100643. If you connect an NLTEK drive to the same Firewire bus as the Adrenaline hardware, the system competes for resources on the bus and video may stutter when playing back from the NLTEK device.

Workaround: When connecting an NLTEK drive to an Adrenaline system, connect the NLTEK drive and Adrenaline hardware to different Firewire buses.

Bug Number: UDevC00105508. When performing a “Check into Interplay for Pro Tools,” two of the three options for Audio Mixdown do not work correctly if you apply the setting from the Avid editor. Selecting "No Mixdown" results in a Stereo Audio Mixdown and selecting "Stereo Mixdown" results in No Audio Mixdown. Selecting "Mono Mixdown" works properly.

Workaround: Select the option for the setting in the Interplay Administrator > Editor Export Settings for Pro Tools view.

Bug Number: UDevC00096276. (Limitation with Interplay Media Services) Clip names containing more than 255 characters are not supported when using Interplay Media Services.

Bug Number: UDevC00096276. (Limitation with Interplay Media Services) Clip names containing more than 255 characters are not supported when using Interplay Media Services.

Bug Number: UDevC00099173. (Interplay Media Services) In an Avid editing application, after you deselect and then reselect the Media Services setting "Media Services are Available," the list of providers in the Media Services sub-menu is not accessible.

Workaround: To provide access to the list of Media Services providers from the Avid editing application you must exit the Avid editing application and restart it.
➤ **Bug Number:** UDevC00099633. Do not use the Windows “Fast User Switching” feature in an Interplay environment. It can lead to confusion about whether the correct drives are mounted for each user. For example, if an Administrator logs on and mounts all drives and then switches to a user that only has access to one or two drives, all drives will still be mounted.

➤ **Bug Number:** UDevC00099012. Interplay Engine E-mail service might be unreliable if there are too many event notices in a short time frame. Some events might be dropped. Workaround: A large number of event notices indicates a problem, so the administrator needs to Investigate the problem in any case.

➤ **Bug Number:** UDevC00099003. Interplay Engine When the Interplay Engine server sends e-mails, it uses the login of the Server Execution User. Make sure the mail server is aware of the username and password of this account (usually a domain account). If not, the mail server might reject the e-mail request. For information on email notification, see the *Interplay Engine and interplay Archive Engine Administration Guide*.

➤ **Bug Number:** UDevC00099458. Interplay Administrator: For best performance, a list of values for a custom property (created in an XML file) should have fewer than 20 entries, and you should not activate more five custom properties that use a list of values. For information on creating custom properties, see the *Interplay Engine and interplay Archive Engine Administration Guide*.

➤ **Bug Number:** UDevC00094813. Avid Low Res Encode Dual Ingest: If you lengthen the duration of a dual ingest to longer than one hour after the ingest has started, the frame accuracy between the high and low res material will be off by two frames at the original end point. This only happens if the final duration is longer than one hour. For example, if you start a one hour recording and then change the recording length to two hours, the high and low res material will be off by two frames at the one hour mark. This happens each time you lengthen a dual ingest clip that is currently recording. For example, if you lengthen the clip three times the final clip will be off by a total of six frames.

**Workaround:** The problem does not happen when you shorten the duration during a record. If you know you are going to change the length of a recording you could originally set it up as a long recording and then shorten it after the recording begins.

➤ **Bug Number:** UDevC00091738. Only applies to bootset 1660 CaptureManager dual ingest with Avid Low Res Encode: If you change the name of a recording and extend the length of the recording while it is in progress, the system flips back and forth between the old and new names for the remainder the recording. The duration will also display incorrect values during the recording. The final recorded media will have the new name and the correct
duration. The problem only happens during the recording. If you want to work with the clip before it finishes capturing you may have trouble searching for it and if you drag the clip into a bin the duration may be incorrect until the clip finishes capturing.

**Workaround:** If you change the name and the capture duration of a clip while it is still being captured, you may have to wait until the capture is complete before you work with the clip.

➤ **Bug Number:** UdevC00096607. During AutoArchive any failed archives are submitted continuously and exceed the maximum number set by the retry setting in the Avid Interplay Service Configuration > Service Settings > Configure AutoArchive window.

**Workaround:** Set the maximum number of retries for a failed job to 1. When a job fails it is moved to the failed folder.

➤ **Bug Number:** UDevC00089277. VC-1 Resolutions are not supported in Interplay v1.2.x or Interplay v1.4.2. VC-1 support was added to the Avid editing applications at the x.8 release (for example NewsCutter v6.8). However, VC-1 resolutions are not supported in an Interplay environment. VC-1 is a SMPTE 421M video codec standard.

➤ **Bug Number:** UdevC00093731. Limitation When using Frame Chase Editing (EWC), if you try to transcode subclips after the capture is complete, the transcode fails indicating the clip is still being captured even though the master clips display “complete”.

**Workaround:** After the master clip of the subclip is complete, re-checkin the subclip to the Interplay database before you start the transcode.

➤ **Bug Number:** UDevC00096386. Interplay Assist Send to Playback: If you perform a “Send Source to Playback” command on a source clip that contains restrictions, the system does not warn you that the clip contains restrictions. Note that the system does display a restriction message when you load the clip in the Source monitor so you are warned at least one time.

➤ **Bug Number:** UDevC00093002. Installing from shared storage: At large sites it is often useful to copy installers to a central shared storage location and run the installers from there. Sometimes when you do this the installers may display an I/O error or complain of a bad or corrupt file. If this problem occurs, copy the installer locally and run it or run the installer from the Avid Interplay Installer DVD.

➤ **Bug Number:** UDevC00092387. Interplay Access license: When you use up all of your Access licenses and try to log in, the system displays an incorrect error message. The error message states that the evaluation period has expired. It should state that you cannot log in because there are no more licenses available.
➤ **Bug Number:** UDevC00093257. You might receive an access violation error while dragging multiple clips from the Interplay Window into a bin. This occurs if you select an individual clip, drag it to the bin and then repeat the process quickly.

**Workaround:** Select multiple clips and drag them to the bin.

➤ **Bug Number:** UDevC000933580. When performing a partial restore of a large sequence, the Job Status and progress bar displays a percentage of the completed job until the Restore Provider is finished processing the job. The process might appear hung during this time.

**Workaround:** You can monitor the Restore Provider to check the job's activity.

➤ **Bug Number:** Avid Interplay v1.2 and Interplay v1.4 do not support MXF media encoded using the VC-1 resolution and codec. The VC-1 codec was initially developed by Microsoft and has been standardized as SMPTE 421-M. The vx.8 versions of the Avid editing applications support editing and playback of MXF media encoded using the VC-1 resolution and codec. Interplay does not support the resolution for this release.

➤ **Bug Number:** Interplay Archive and Restore upgrades: Before starting the upgraded archive/restore provider applications, delete the contents of the C:\Temp folder. Perform the task when the archive/restore provider applications are not running. You can perform the deletion before or after you upgrade the software.

➤ **Bug Number:** UDevC00092202. If you have used the NXNServerUser.exe tool to change the Server Execution user, the Interplay Engine installer uses the old value when you upgrade to this release. In this case, if you don’t use Custom install and supply the correct value, you will have problems with the cluster. For example, the cluster will not be able to fail over.

**Workaround:** On a cluster, use the Custom install option and make sure you supply the correct Server Execution user when prompted. See “Checking the Server Execution User Account on a Cluster System” on page 21.

➤ **Bug Number:** UDevC00092128. Checking a Bin into Interplay while a capture is in progress: If you check in a bin while a capture is in progress, the clip associated with the capture may not be checked into the Interplay database.

**Workaround:** Perform an Update Status from Media Indexer command in Interplay Access and the status will be correct.

➤ **Bug Number:** UDevC00086972. Media Services Transcode: If you submit two transcode jobs for the same source file, and each job uses a different provider, the transcode might fail with a DISK FILE NOTE FOUND error.
**Workaround:** Try the operation again. If you get the same error message, check if the source clip is corrupted, that your configuration is correct, and that all Interplay components are running correctly.

➤ **Bug Number:** UDevC00087103. Media Indexer: If the media indexer service does not start after a reboot you will need to manually start it using the Avid Interplay Workgroup Properties tool. For information on starting the service automatically, see “Additional Information for the Service Framework Lookup Service” on page 28.

You must use Interplay Service Configuration tool to ensure that the Avid Service Starter Service automatically restarts other services, such as the Interplay Media Indexer service. For more information, see the Interplay Software Installation and Configuration Guide.

➤ **Bug Number:** UDevC00091228. Selecting Check In All Open Bins from the Fast menu in the bin might not check in the open bins.

**Workaround:** To check in all open bins, select Check In All Open Bins from the File menu.

➤ **Bug Number:** UDEV00091445. “Check into Interplay for Pro Tools” command: Automatic renders occurring during command execution appear offline for the Pro Tools editor if the source media is on a local drive.

**Workaround:** If you have a sequence that contains local media and you apply effects to it, render the sequence in to out and explicitly select a shared Unity volume during your manual render. After the render is complete, use the Check into Interplay for Pro Tools command.

➤ **Bug Number:** UdevC00090469. Disconnect mode: If you are working on an editing system that is disconnected from Avid Interplay (using Disconnected Client mode), you cannot create OMF audio. If OMF is selected as the media type in the Media Creation settings, and you open the Audio Project setting, the Audio File format is set to PCM and cannot be changed.

➤ **Bug Number:** UDEVC00090431. In Interplay Assist, if you change the name of a clip and then archive it, the original name (not the new name) appears in the Job tab of the Interplay Media Services window. The name appears correctly in the Archive Manager and is archived correctly.

➤ **Bug Number:** UDevC00091115. If you use ProEncode to encode a clip that has already been encoded, you get a message that states that the movie file already exists and asks if you want to overwrite it. If you answer yes, ProEncode overwrites the movie file but does not overwrite any associated audio files. Existing audio files are saved with a version number.

**Workaround:** Delete the old files manually.
➤ **Bug Number:** UDevC00090855. In Interplay Access, the Disk Label field does not display the XDCam disk label.

➤ **Bug Number:** UdevC00090905. The Migration Tool supports the default SQL server setup. The tool does not support a SQL server using an instance name or port other than the defaults.

**Workaround:** You can either reinstall the SQL server using the default setup or run the Migration Tool from another SQL server. To use a non-standard port number, you need to enter the hostname in the Migration Tool using one of the following formats:

mySQLserver:4027 or mySQLserver/portNumber=4027

In this example, mySQLserver is the hostname of the SQL server, and the port number used is 4027.

➤ **Bug Number:** . You cannot perform a partial restore operation with OMFI media files. If you want to take advantage of partial restore with material that you have migrated from a MediaManager environment, you must re-archive the material in an Interplay archive.

➤ **Bug Number:** UDevC00088720. Interplay Assist memory problems and sluggishness. If Interplay Assist encounters .pmr files in the Avid MediaFiles folder on shared storage, it will attempt to work with the files. This can interfere with the application’s use of the Media Indexer to locate files and can cause Assist to have memory problems and sluggishness. The .pmr files are used by standalone Avid editing applications (editors that are not connected to Interplay).

**Workaround:** Check the shared storage areas used by Assist for .pmr files. Look in the Avid MediaFiles folder. Either delete the .pmr files or point Assist to another workspace.

➤ **Bug Number:** UDevC00090952. In Interplay Assist, if you select Media > Mount Volumes, the Scanning for New Volumes window opens and does not close. You can continue to work by clicking in the Assist application, but the Scanning for New Volumes window stays open behind the application.

**Workaround:** Mount the drives you need before you start Interplay Assist.

➤ **Bug Number:** UDevC00081178. FTP Ingest of XDCAM HD 24p is not supported.

**Workaround:** Use the Firewire ingest method. For details, search for “Connecting the XDCAM Device” in the Help for your Avid editing application.

Avid MediaStream™ native ingest is not supported for this release.
Bug Number: UDevC00090719. Audio clips that are online may display a partially online icon in the bin. You can play and edit the media normally and the clips appear correctly in the Timeline.

Bug Number: UDevC00090212. Clips captured from an Airspeed system through Capture Manager might display the Creation Date as the completion time instead of the start time. This is possible with clips 30 minutes or longer.

Bug Number: UDEVC00090615. Using 720p media with Assist: If Dynamic Relink is turned on for Assist and Instinct, you cannot hear the audio portion of a 720p clip that was captured by AirSpeed.

**Workaround:** Turn off Dynamic Relink for Assist and Instinct as follows: Open the Interplay Administration tool, open the Editor Database Settings view, and select False to disable Dynamic Relink. Note that this turns off Dynamic Relink for all Assist and Instinct users.

Bug Number: UDEVC00088720. Avid Assist and .pmr files: If there are .pmr files present on a shared storage workspace, Assist can have performance problems because it attempts to use the .pmr files and Media Indexer information at the same time. Note that .pmr files are created by standalone Avid editing applications that are not part of the Interplay environment.

**Workaround:** Check the workspace for an Avid MediaFiles folder or an OMFI MediaFiles folder containing .pmr files. Determine whether you should delete the folder or have the Assist applications use a workspace that does not contain those folders.

Bug Number: UDevC00089372. In Avid iNEWS, you cannot use the German characters “µ” or its uppercase equivalent “M” in the directory tree for folder or queue names.

Bug Number: UDevC00085343. If you run multimedia third-party software on your Interplay Assist system, you might not be able to play video and audio, even though you can see the video when you shuttle through.

Bug Number: UDevC00088912. If you create locators in Interplay Assist and then update them in an Avid editing application, the locators don't update within Assist even if you press F5 to refresh the application.

**Workaround:** Workaround: Reload the shotlist to see the updated locators.
➤ **Bug Number:** UDevC00086432. Dynamic Relink, FlightPlan, and 720p 59.94 and 50 media: The audio can go offline for these resolutions if you have dynamic relink turned on and set to the default “if no match is found, Relink to Offline”. This only happens when you use FlightPlan to transfer Airspeed-captured media to a bin.

**Workaround:** If the audio goes offline in this case, change the Dynamic Relink setting to “Closest Media”. Then right-click the clip in the bin and select “Update from Interplay” to update the clip.

➤ **Bug Number:** UDevC00085624. Checking out a sequence while the original sequence is loaded in the source monitor might crash the Avid editing application. This only happens if you have the sequence loaded and are in either Effects mode or Color Correction mode.

➤ **Bug Number:** UDevC00081218. ProEncode Provider disk full errors: You might have to restart the ProEncode provider and Telestream FlipFactory™ systems if jobs fail due to a lack of disk space. Even if you make room on the disc, the jobs will fail until you restart the systems.

**Workaround:** As part of your normal disk management operations, periodically check the size of the following folder:

```
Program Files\Telestream\FlipFactory\http\Media
```

Telestream copies work files to this folder and does not automatically delete them. Periodically delete the files in this folder.

➤ **Bug Number:** UDEVC00078370. Sequence with Color limiter effect on filler might crash Avid Assist.

**Workaround:** Render the effect in the Avid editing application.

➤ **Bug Number:** UDEV00080383. Cannot save Boris Effects templates to bin after checkout from Interplay.

**Workaround:** Save the template to a bin before checking the sequence into Interplay.

➤ **Bug Number:** UDEV00054142. Bin display settings for the Interplay Window do not persist when changing folders.

**Workaround:** You can select the media search tab and then go to the bin menu and select Set Default Interplay Window Display. However, by doing so, you change all folders views within Interplay.
Bug Number: UDevC0081331. The Interplay Media Services status window is not reliable when you submit a ProEncode job that performs several encode jobs (for example, convert one source file to .mov, .wmv, and .mp4). The following problems occur:

- The status bar might turn green before all of the encode jobs are completed.
- Even if one of the subsequent encode jobs times out and fails, the bar stays green.
- The status bar might hang at 100% yellow indicating that an encode job is not finished, even though ProEncode has moved on to process the second job. Then it might turn green before all the jobs are complete.

Workaround: Do not create monitors in Flip Factory when you are creating profiles for ProEncode. If ProEncode is processing the job and Flip Factory picks up the same job, a conflict can occur.


Workaround: Use the Bin > Consolidate/Transcode command in the Avid editing application.

Bug Number: UDevC00079824. AutoArchive: If you attempt to perform an AutoArchive operation with a profile that does not exist, the system returns the following error: “Unable to start job...ProviderException: 20...Parameter missing...” This can happen if you assign a profile to an Autoarchive folder and then delete the profile later on.

Workaround: Assign or create a new profile for the autoarchive folder.

Bug Number: UDevC00078380. Media Services Transcode: You cannot use Media Services Transcode to transcode a motion effect clip. The system displays the error “Invalid Media Type. Transcode Failed.”

Workaround: Do one of the following:

- Use the Bin > Consolidate/Transcode command in the Avid editing application to transcode the motion effect clip.
- Transcode the source master clip that makes up the motion effect using either Media Services or Avid editor transcode.

Bug Number: UDEVC00050258. If you restart the Media Services engine while the Archive, Restore, or Transcode providers are running, the services do not start up automatically, even if you have configured them to do so.

Workaround: Quit and restart the services.
Bug Number: UDEVC00051583. Checking in a Duplicate clip with a restriction: If you create a duplicate of a clip that contains a restriction, and then check the clip into the Interplay database, the red triangle doesn’t automatically appear on the duplicated clip.

Workaround: Click the duplicated clip in the Interplay Window (to set focus to the window) and press F5 (to refresh). The red triangle appears.

Bug Number: Custom Metadata fields: If you create custom metadata fields in the Interplay Administrator, Interplay Access, or Interplay Assist, you cannot delete them or turn them off for this release. However, you can now turn off the display of individual custom metadata fields. See the Avid Interplay Access User’s Guide for more information.

Bug Number: UDevC0090853. 720p – 220/185x Rolling Crawling Titles and Dynamic Relink: When using 720p – 220/185x, you cannot use the “relink to offline” and “specific resolution/dnx220x” Dynamic Relink settings with a rolling title that is more than two pages long. The system displays a wrong format error when you load the title in the source monitor. The title becomes corrupt and must be recreated.

Workaround: Turn off Dynamic Relink and recreate the title media. The problem does not occur if you use the “Use Closet Media” value in the “if no match is found” setting.

Bug Number: UDEVC0051900. Rendered titles show two resolutions in Interplay Access. This is as designed. When the Avid editing application renders a title, it creates two media files: one in the target resolution, and a second in MXF 1:1 resolution. When you check the title in to Avid Interplay, both media files are checked in. Interplay Access lists the MXF 1:1 resolution as the current video resolution. When you delete a rendered title from Interplay Access, select both resolutions.

Bug Number: UDEVC0025865. If you perform a Bin View Save As operation for a bin that contains resolution columns, the resolution columns are not saved. Any other columns you saved will work correctly. When you apply that Bin View to another bin, the system displays the following error message:

“One or more columns in the view are not relevant in this kind of project and will not be displayed.”

Workaround: Manually add the resolution column to the bin.

Bug Number: UDEVC00052480. Batch Import of files containing Alpha: This problem occurs if you want to batch import files in SD and HD formats and then use Dynamic Relink to switch between the different formats. The problem occurs with QuickTime movies, graphics, and sequences that contain alpha. You can batch import the files and relink to the
different formats, but if you exit and then restart the Avid editing application, you can no longer relink to the HD format. The system displays an “Exception: NO Compressed Data Format found” error message.

**Workaround:** You cannot use Dynamic Relink with HD and SD clips that contain alpha. Import the HD files with alpha as individual clips. When you want to switch to HD format, edit the HD versions into your sequence.

➤ **Bug Number:** UDEV00230928 UDevC00026052. XDCAM HD imports: If the Avid editing application is using more than 40% of available memory, importing XDCAM HD low-resolution proxy clips into a bin might fail with a bad allocation exception error message.

**Workaround:** Close some bins to free up memory (especially bins containing many objects). You can view the memory usage in the Bins tab of the Project Window.

➤ **Bug Number:** . In Avid Interplay Assist and iNEWS Instinct, avoid displaying more resolution columns than you need. The system frequently updates the status in the resolution columns and having too many active can affect performance. Sequences can be especially slow to update when there are many resolution columns. Once columns are displayed, they continue to impact performance for that session even if you hide them. If you reduce the number of resolution columns and save the column layout, you won’t see a performance improvement until you restart the application.

➤ **Bug Number:** UDEV00225692 UDevC00024104. Folders containing assets marked with reservations appear in Interplay Assist, Instinct, and the Interplay Window with the reservation marker, but the individual asset type icons in the Research panel do not display the marker.

➤ **Bug Number:** UDEV00218247 UDevC00024136. Delete dialog box naming conventions: Some of the naming conventions in the Interplay Access Delete dialog box do not match the resolution names in the Avid editing application bin. For example, the following list shows some differences.

<table>
<thead>
<tr>
<th>Media Composer bin</th>
<th>Delete dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dnx145</td>
<td>DnX HD 6:1</td>
</tr>
<tr>
<td>1:1</td>
<td>Uncompressed</td>
</tr>
<tr>
<td>DVCPro HD</td>
<td>DVCPro HD 9:1</td>
</tr>
<tr>
<td>Dnx220</td>
<td>DnX HD 4:1</td>
</tr>
</tbody>
</table>
Windows User Account Requirements

The following limitations exist for Interplay:

➤ **Bug Number:** UDevC00052215. Avid editing applications such as NewsCutter, Media Composer, and Symphony that are part of an Interplay environment can use a regular Windows User login. However, when you install the application you must first log in as an Administrator, install the application, and initially launch the application as an Administrator. See the Avid editing application Readme for details.

➤ **Bug Number:** UDevC00088970, 89118. Avid Assist and Avid Instinct have similar limitations: When you install the application, you must first log in as an Administrator, install the application, and initially launch the application as an Administrator. You may then subsequently run the application as a regular User.

➤ **Bug Number:** UDEVCC00098723. Regular Windows user login and Media Creation tool: When you select Auto-Indexing in the Avid editing application Media Creation tool, the system creates duplicate storage items in the Media table for the local Media Indexer. This can happen every time the Media Indexer scans the local storage drives or P2 drives. If it continues to occur the Media Indexer can become unresponsive and you could get Media Offline messages.

**Workaround:** To determine whether you are experiencing this problem, open the Service Configuration tool, select the editing system, and then select the Media Indexer process. Click Configure, and see whether there are duplicate entries for your local storage locations. If there are duplicate entries, delete the duplicate entries and do one of the following:

- Periodically check the Service Configuration tool and delete the duplicate entries
- Log on as a Windows Power User or Administrator.
- Disable the auto-indexing feature. Instead, click on "Manual scan" every time changes are made to the drives available to the editing system.

➤ **Bug Number:** UDEVC00089275. Changing Users on MediaNetwork Fibre attached clients: When you change users on a fibre attached client, do not use the Switch User function in the Windows Log Off dialog box. When you log back in as the original user you may get the following errors when you play media:

Exception: FILE_OTHER, filename:… Exception: SYS_ERROR, status:1317, msg:The specified user does not exist.
**Workaround:** To fix the problem once it occurs, reboot the system. To avoid the problem, before you switch users, log off completely and reboot the system.

**Clips from the Same Tape That Have Overlapping Timecode**

➤ **Bug Number:** UDevC00055238, UDevC00055241, UDevC00055244, UDevC00055249.

This section describes several limitations that involve clips from the same tape that have overlapping timecode. The problem is most evident when the two clips are captured at different resolutions. This can happen when you do the following:

1. Use the Capture tool to capture a clip.
2. Change the capture resolution.
3. Back up the tape a little, and start capturing again at the new resolution.

Now you have two clips and two separate media files. The end of the first clip and the start of the second clip share the same timecode.

You see the following problems with these clips:

- In the Interplay Access Object Inspector, each clip displays as a separate media file, each at its captured resolution. However, the Avid editing application sees the clips as sharing media. If you display the clips in an editor bin and display column headings for both resolution types, both clips show at least a partially online status for each resolution.

- If you send the low-resolution version of the clip to Media Services Transcode, the system uses the high resolution for the Transcode. This produces a higher-quality result but takes longer than transcoding a low-resolution version.

- If you delete the media from the first clip and then load the clip into the editor Source monitor, you see the media from the second clip. However, if you attempt to Transcode the clip, you get an error message because the actual media for the clip has been deleted. This can be confusing because you see an online version of the clip but can’t transcode it. The clip is linking to a different media file in the editor Source monitor but the media is not associated with the metadata for the clip.

In this last scenario, if you look at the clip in the Interplay Access window, you see a red X that indicates that the media is not available. There is no corresponding display in the editor bin.
Disabling the Onboard NIC on an HP xw8400 Causes System Instability

The *Avid Interplay Software Installation and Configuration* guide contains the following information:

Computers with Multiple Network Interfaces

“If you have multiple network interfaces on a computer and one is not used, use the Device Manager to disable the interface. If not, the computer may have problems communicating with the Service Framework Multicast Repeater.“

The following information should be added to that section regarding the HP xw8400:

Do not use the Device Manager to disable the onboard network interface card on an HP xw8400. Doing so could cause intermittent hard hangs (no keyboard input or mouse movement) or other system instability such as unexpected reboots. Instead, use the following procedure.

**To disable the onboard network interface card via the BIOS:**

1. Boot, or reboot, the system
2. Press the F10 key when prompted to enter BIOS setup
3. Choose your preferred language when prompted to enter Setup.
4. Once into the BIOS, use the right arrow to navigate to the Security Menu
5. In the Security Menu, select Device Security
6. In the Device Security selection window, use the down arrow to select the Network Adapter.
7. Use the right arrow to change the option to read “Device Hidden” instead of “Device Available.”
8. Press F10 to save your setting change.
9. Press F10 again to get to the Save Changes and Exit prompt.
10. Press Enter to select Save Changes and Exit.
11. Press F10 to Save and Exit.

International Character Support Limitations

➤ **Bug Number:** UDev00089590. Workspace names: Workspace names that contain non-ASCII characters can cause poor performance when working in a bin.
Workaround: Use only ASCII characters in workspace names.

Bug Number: UDevC00089671. Workspace names in Asian characters might appear truncated at the end in any drive-selection list.

Workaround: When using Asian characters, use no more than 5 characters for workspace names.

Bug Number: Archiving does not support ICS for this release.

Bug Number: UDevC00052231. If you enter Asian characters as restriction information, the characters might appear as question marks when you view that restriction in another Avid application.

Bug Number: UDevC00051974. If you capture a clip from a workspace with a French name through CaptureManager, in the Avid editing application the bin heading Drive might be empty where it should list the French name of the workspace.

Bug Number: UDevC00051060. If you change the font or font size of your input, and see characters rotated 90 degrees, make sure you select the correct font. Do not use any font that begins with the “@” symbol.

Bug Number: UDevC00052541. Do not create a Project using the Euro currency character (ALT 0128). The Project fails to be created and a “Can't Open Project” error message is displayed.

Bug Number: UDevC00022395, 22346. Certain Asian characters might not appear in the correct order in some text boxes in your Avid editing application.

Bug Number: UDevC00078651. Use only ASCII characters in passwords.

Interplay Access Limitations

Bug Number: none. Compatibility with prior versions: The Interplay Engine or Interplay Archive Engine and the Interplay Access client must be updated at same time. Interplay Access clients will not work with older Interplay Access Engines or Archive Engines and vice-versa.

Bug Number: UDEVc00035172. Multi selection drag and drop issue when one file asset already exists in target folder: When a multi selection is dragged and dropped and one of the file assets exists in the target folder already, no files are moved and the results are not as the user would expect. This is the result of a rollback of the transaction and appears as follows:
Limitations

- Red check marks (indicating a check out) turn blue. The checkout path has already been moved to the new location, so when the file is moved back to the original location but the checkout path is not updated again, the check mark appears blue. These items can be checked in again safely.
- The local copies of not checked out assets seem to be deleted. The local copy of the asset is not actually deleted, it is just not moved back to the original location.
- The file that exists in the target keeps its local copy.

➤ **Bug Number:** UDEVC00039014. Working in a folder during an import causes problems: When performing a large import, working in the same folder you are importing to might cause problems with the import. You might be prompted to refresh your view, in which case the import was successful. In other cases, a message indicates that the import failed and you need to perform the import again, without touching the folder.

➤ **Bug Number:** UDEVC00038766. Get latest on extremely large folder causes problems for user Administrator: When the user Administrator performs a Get Latest on a folder that contains assets in number approaching 50,000, a potential problem might occur; the client slows down, but the operation actually continues. If the client reaches the free memory limit, a corresponding message is shown and the operation is cancelled. This does not occur if another user (not Administrator) has performed a Get Latest on the same machine already.

**Workaround:** Users should perform a Get Latest on the smallest range of items possible, such as a subfolder.

➤ **Bug Number:** UDEVC00039061. Internally used file name appears for Avid Assets renamed to blank name: If a blank name or only spaces is entered in the Rename dialog for an Avid asset, the internally used file name (mob id) appears as the name instead (long string of numbers and letters).

➤ **Bug Number:** none. Tree state is only remembered on the same machine: The tree state upon logout is remembered the next time you log onto Interplay only on the same machine (stored per user, per machine).

➤ **Bug Number:** UDEVC00007386. Issues with preview of large text files: Text files over 1MB are not shown in the Preview by default, however, if you explicitly click the Show File button for these large files, low memory problems may occur.

**Interplay Access Integrations**

➤ **Bug Number:** none. Before you can use the Microsoft Office and Photoshop Integrations, you must start the Interplay Access one time. This ensures that the Interplay database is ready to work with the integrations.
**Interplay Access Media Player**

➤ **Bug Number:** none. The Media Player allows you to play non-Avid files from Interplay Access. You can install QuickTime 7 to extend the set of formats to all media formats supported by Quicktime 7. For more information on the Media Player, see the Avid Interplay Access User’s Guide.

**Interplay Administrator Limitations**

➤ **Bug Number:** . As part of daily maintenance, the Interplay Administrator should monitor the number of Journal files on the Interplay database. See “Monitoring the Integration of Journal Files into the Database” on page 35.

➤ **Bug Number:** UDEV00210720, UDEVC00037618. Limited number of clients per user per machine: Only one Interplay Access instance and one Interplay Administrator instance can run at a time on one machine per user. This software will not support terminal server sessions.

➤ **Bug Number:** none. Low disk space issues: In low-disk-space situations, the Administrator cannot log on and shut down the server, and move databases by normal means. There are tools provided to solve such problems (available in the Installation CD’s Tools directory or installed by default in the Server installation directory):

- NxNServerLock.exe
- NxNServerUnlock.exe
- NxNServerShutdown.exe

**To move databases under low disk space conditions:**

1. Lock the server using NxNServerLock.exe.
2. Shut down the server using NxNServerShutdown.exe, if necessary.
3. Move the databases to another drive or free up some disk space.
4. Unlock the server by doing one of the following:
   - Use the Interplay Administrator’s Lock Server view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details)
   - Use NxNServerUnlock.exe
5. Deactivate any moved databases using the Interplay Administrator’s Manage Databases view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details).
6. Activate any moved databases in the correct location using the Interplay Administrator’s Manage Databases view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details).

➤ **Bug Number:** UDEVC00039474. Passwords should only include ASCII character set: User passwords should only include the ASCII character set. Multibyte passwords might cause logon problems.

**Workaround:** If logon with a multibyte password fails, the administrator should reset the password in the User Management view of Avid Interplay Administrator.

➤ **Bug Number:** UDEVC00006908. Limitation: Browse for new data location does not show mounted workspaces on Avid ISIS in the tree: In the Create Database view in the Interplay Administrator, when you click Browse in the New Data Location (Assets) section, the mounted workspaces on a Avid Unity™ ISIS® shared storage might not be shown.

**Workaround:** Type the path manually.

➤ **Bug Number:** UDevC00007123, UDEVC00039984. Voice over target workspace field says “No Items to Show”: An administrator logged in to the Avid Interplay Administrator may see “There are no items to show” in the Editor Database Settings view in the field Voice over target workspace field instead of the drives. This is intended behavior: the administrator must also be a Avid Unity user with the same credentials in order to see the workspaces of the Avid Unity. If the workspaces are not visible, check that:

- The user is a user on the Avid Unity.
- The user has the same password as the user on the Avid Unity.
- The Avid Unity is reachable.
- The user is allowed to see the workspaces.
- There are actually workspaces at all.

### Configuring Remote Workgroups

➤ **Bug Number:** UDevC00051760. In order to use the Configure Remote Workgroup view in the Interplay Administrator tool, you must have matching Administrator accounts on both workgroups. The accounts must have the same user names and case-sensitive passwords. For more information on user names and passwords, see the *Avid Interplay Software Installation and Configuration Guide*. 
Archive and Restore

➤ **Bug Number:** UDEVC00052832. Archive Provider: Windows Message Queuing software must be enabled on the Archive Provider. If you perform a clean install on a system that will run the SGL FlashNet client, you must enable the Windows Message Queuing software. This applies to any system running the Interplay Media Services Archive Provider. If the Windows Message Queuing software is not running, jobs fail to archive. For details, see the Interplay Media Services Readme.

➤ **Bug Number:** . Archive Provider: The Archive Provider also requires the SQL Native client software. This is usually installed and configured by your SGL representative. For more information, see the Interplay Media Services Readme.

Avid Low Res Encode

When you are using Avid AirSpeed and Avid Low Res Encode to perform a dual ingest, it is important that you lock your video signal to your timecode source. For example, you can connect a video feed and a Time of Day timecode device into a sync device to lock the incoming video and audio with timecode.

It is also important that the two capture devices are in sync. If the captured high-res video and low-res video are off by a few frames, you should delay the video signal going to one of the capture devices in order to ensure that the two video signals match.

➤ **Bug Number:** . An Avid Low Res Encode system can capture a clip up to four hours in length.

➤ **Bug Number:** UDEV00226140 UDevC00039921. You must specify a valid NTP time server when configuring an Avid Low Res Encoder. You can specify the NTP servers in the Avid Low Res Encode web page configuration. Many of the commands that are issued from the CaptureManager server to the Avid Low Resolution encoder are based on the system time of the CaptureManager clock. If the two clocks drift far enough apart, the Avid Low Resolution encoder-received commands could be interpreted as being too early or too late to be performed properly.

➤ **Bug Number:** UDEV00220820 UDevC00039193. Dual IPV and AirSpeed ingest: The first second and the last second of the capture are offline.

➤ **Bug Number:** UDEV00221170 UDevC00023600. Instinct and low res MPEG2 media: In the Instinct Research panel, you can edit the information in the MPEG2-MPML352x250 & 288 column. The system should not allow you to write in this column. Normally there should just be a dot in the column indicating whether the resolution is online or offline.
Limitations

➤ **Bug Number:** UDevC00089384. When performing a dual ingest with CaptureManager and Low Res Encode, you will occasionally get more low res frames than high res frames.

**Workaround:** If the CaptureManager cannot sync exactly with the Low res Encode system, it may intentionally capture additional low resolution frames. This ensures that you will be able to link the high resolution media with the correct amount of low res media.

**Avid Unity MediaNetwork and Avid Unity ISIS**

➤ **Bug Number:** . An Interplay client cannot be physically connected to more than one Avid Unity shared storage system at the same time. For example, a single client cannot be physically connected to an Avid Unity ISIS and an Avid Unity MediaNetwork system at the same time. The same applies to connecting to two different Avid Unity MediaNetwork systems at the same time. Use the Workgroup to Workgroup transfer feature to move files between different shared storage systems.

**Checking in Avid Assets**

➤ **Bug Number:** UdevC00092889. When creating and checking in a clip or finding a clip in the Avid editing application's Interplay Window, if the clip name contains a slash (\ or /), the application hangs for about one minute then returns to normal.

**Workaround:** Remove the slash from the clip name.

➤ **Bug Number:** UDevC00089019. Checking in bins with deleted clips: When you check in a bin, the Avid editing application determines whether clips need to be checked in based on whether you have modified them or added them to the bin since the last check in. If clips have been deleted from Interplay since the last check in, checking in the bin will not check in the deleted clips again. You need to force a check in of the deleted clips. To force a check in, select the clips and then select Check In To Interplay from the File menu or bin context menu. To force a check in of an entire bin, select all clips in the bin and select Check In to Interplay.

➤ **Bug Number:** . When you check a large sequence into the Interplay database from the Avid editing application, the check in can take several minutes. The system provides an initial progress bar to let you know that the checkin has initiated and that you can now get back to work with the application. However, there is no additional indication to tell you when the checkin has completed. This can be a problem if you check in a large sequence or a bin with many sequences and you don’t see it appear right away in the Interplay Window.

**Workaround:** If you check in a large sequence and it doesn’t appear right away in the Interplay Window or Access, return to the window in a few minutes to see if the checkin has completed.
Deleting Files from the Interplay Database

➤ **Bug Number:** UDevC00025736. Try to schedule large file deletions (for example, over 300 GB) during off hours. A large delete operation can slow down the response time on the Avid Interplay Engine. This also slows down the response times on Avid editing applications that are working with the Interplay Window.

➤ **Bug Number:** . If you create shared media using a local bin, and later delete that media without ever checking the clips into the Interplay Window, the clips’ metadata is not deleted from the “Unchecked in Avid Assets” folder. An administrator can delete this metadata as part of normal system maintenance. This only happens to clips that have not been checked in to a folder in the Interplay window.

Dynamic Relink and 24p Projects and Other Projects with Pulldown

➤ **Bug Number:** . Dynamic relink is automatically disabled in 24p and 23.976 projects. It is also automatically disabled in NTSC matchback projects.

➤ **Bug Number:** . All resolutions that are eligible for dynamic relink must use the same frame rate. For example, you cannot dynamically relink a 30i master clip in the Timeline to 24p media. You can, however, dynamically relink a 30i master clip to a 1080i/59.94 master clip.

Editing

➤ **Bug Number:** UDevC00083980. Viewing media folders in the Interplay database from Assist, Instinct, and Interplay Window: Occasionally when you launch Assist, Instinct, or one of the Avid editors, the following occurs:

- In Assist and Instinct, no media folders are visible in the Directory panel.
- In the Avid editing application, no project folders are visible in the Interplay Window.

**Workaround:** Restart Assist or Instinct. For the Avid editing applications, log out of the Interplay Window and log back in.

➤ **Bug Number:** UDEVVC0021278. Transcoding Titles: You cannot transcode the titles in a sequence to another resolution. If you transcode a sequence with a title in it, the sequence is transcoded but the title is not transcoded.

**Workaround:** Recreate the title in the new resolution or reimport the original matte key.
Bug Number: UDevC00025855. Creating subclips - After you drag a clip to a local bin from the Interplay Window, you cannot use the simple drag-and-drop method to create a subclip. The simple drag-and-drop method involves loading the clip into the monitor and then dragging it from the monitor to the bin.

Workaround: Alt+drag the clip from the monitor to the bin or use the Subclip button.

Bug Number: UDevC00036994. Deleting media from a master clip might not update the online/offline status of the associated group clips or subclips in Interplay Access.

Workaround: Return to the Avid editing application bin and check the group clip in to Interplay Access again by dragging it into the Interplay Window.

Bug Number: UDevC00021148. When you search for non-alphabetic characters in clip names in the Interplay Window of an Avid editing application, the search results might not be accurate.

Workaround: Searching in Interplay Access finds the non-alphabetic characters correctly.

Bug Number: UDevC00024672. If you drag an unnamed clip into the Interplay Window in an Avid editing application, the clip might appear in the Interplay Window with no name or with its original name and might appear in Interplay Access with a numeric name.

Workaround: Name clips before you drag them into the Interplay Window.

Bug Number: UDevC00052609. Editing apps If you import a graphic from your local drive into a project in an Avid editing application, change the original name of the clip to a name of your choice, and check that clip into a folder in the Interplay Window, the new name does not appear in the Interplay Window even when you refresh the window. You see only the original name.

Bug Number: UDEV00217606 UDevC00023944 Editing Apps. In the Avid editing application, the Record Track monitor buttons might be deselected if the following happens:

1. On System 1, you create a sequence and check it into a folder in the Interplay Window.
2. On System 2, you check out the sequence and load it into the Timeline.
3. On System 1, you edit the sequence and check it into the Interplay folder again.
4. On System 2, you refresh the Interplay window then check out the same sequence again.

Workaround: Select the Record Track buttons again.
Bug Number: UDEV00216346 UDevC00023435 Editing Apps. If you consolidate a MultiRez master clip at a particular resolution, and either drag it into the Interplay Window or check it into Interplay Access, it might be available at only the resolution you had set when you consolidated the clip.

Bug Number: . The Avid editing applications might encounter the following errors using AVXTM plug-ins:

- Running out of memory with AVX plug-ins
- Check-in and check-out errors with sequences containing AVX plug-ins
- Unable to render AVX plug-ins

Bug Number: UDEV00215167 UDevC00023009 (as designed) . Avid editing application: The OMF® option is not available in the Media Creation settings on a system that is part of an Avid Interplay environment.

Edit While Capture (Frame Chase Editing)

Bug Number: UDevC00086768. You may see the following error message when loading a clip captured by Frame Chase capture in the editor:

“Error encountered during relink process: New track length does not equal original track length.”

Workaround: In the editing application, right click the clip and sequence and select Update from Interplay. In Assist, refresh the clip from the Interplay database by selecting the clip and pressing F5.

Bug Number: UDevC00080038. When you perform a Frame Chase capture of a DNxHD 45 clip, the master clip displays incorrectly in Interplay Access as 1080 36.

Workaround: The clip is still useful as DNxHD 45. Subclips created from the masterclip show as DNxHD 45. The clips show the correct resolution in the Avid editing application.

Bug Number: . You cannot perform a Send to Playback operation while capturing from AirSPACE.

Workaround: Wait until the capture is complete and then do the Send to Playback.

Bug Number: UDevC00035776. Frame Chase Editing: The system returns a Disk Space Error if you attempt to perform a workgroup transfer on a sequence that contains a clip that is currently being captured.
**Workaround:** Wait until the system finishes capturing the clip, and then perform the workgroup transfer operation.

For more information on Frame Chase Editing, see the *Avid Interplay Transfer ReadMe*.

**Folder Limitations**

➤ **Bug Number:** none. It is important that you do not store more than 20,000 assets in Interplay database folders. In general, you can keep up to 5,000 assets in a folder without affecting system performance. One of the problems with storing many assets in a folder is the amount of time it takes to list the items in the folder when you open the folder for browsing.

Periodically check that folders do not contain more than 5,000 assets. Delete or move assets to other folders. If a folder must contain a large number of assets it is more efficient to add multiple subfolders for storing the assets.

This limitation also applies to ingest folders. If you know that you will have recurring ingests, you could set up folders for those ingests. For example, you could name folders for the days of the week or for specific types of ingest.

**Film Projects**

➤ **Bug Number:** UDEVC00080131. Media Services Transcode does not support progressive film resolutions.

**Workaround:** Use the Consolidate/Transcode command in the Avid editing application.

*You can use Media Services Transcode to transcode progressive HD resolutions 720p and 59.94. Those are not film resolutions.*

➤ **Bug Number:** UDevC00025645. Editing Apps In a film project, if you capture a clip at one resolution and then try to batch capture it at a different resolution, the media is not deleted and the clip links to only one resolution (dynamic relink is not available for film projects). This can cause orphan media files.

➤ **Bug Number:** UDevC00083571. If you have film projects and non-film projects on the same Interplay database, do not check film clips into the non-film projects. For example, the following scenario causes problems:

1. Check a film clip that contains audio and video into an 23.976 NTSC project.
2. Check the clip out and then check it into a 23.976 NTSC 35mm 4 perf project.
3. Check the clip out to the film project.
In this scenario, the system strips away the video.

**Importing File Assets**

- **Bug Number:** UDevC00038006. If you check a Marquee™ Settings File (*.mqp) and/or an Image File (e.g., PNG, JPG, PCT, TIFF, PSD) into Avid Interplay Access, you can’t drag the newly created asset into a bin.

  **Workaround:** Do the following:
  1. Select the graphics file in Interplay Access and then select Get Latest from the context menu. The file is copied to the working path on the local drive.
  2. Use the Avid editing system’s Import feature to import the graphic from the working path.

  For more information, see the *Avid Interplay Access User's Guide*.

**Interplay Access and Interplay Engine Limitations**

This section lists limitations for Interplay Access and the Interplay Engine

**General Limitations**

- **Bug Number:** UDEV00210720, UDEVC00037618. Limited number of clients per user per machine: Only one Interplay Access instance and one Interplay Administrator instance can run at a time on one machine per user. This software will not support terminalserver sessions.

- **Bug Number:** UDevC00079500. The Duplicate command is not available on Mac OS X Access clients.

**Interplay Access Media Player**

- **Bug Number:** None. The Media Player allows you to play non-Avid files from Interplay Access. You can install QuickTime 7 to extend the set of formats to all media formats supported by Quicktime 7. For more information on the Media Player, see the Avid Interplay Access User’s Guide.
Interplay Access Integrations

➤ **Bug Number:** None. Before you can use the Microsoft Office and Photoshop Integrations, you must start the Interplay Access one time. This ensures that the Interplay database is ready to work with the integrations.

Interplay Access Limitations

➤ **Bug Number:** UDEVC00035172. Multi selection drag and drop issue when one file asset already exists in target folder: When a multi selection is dragged and dropped and one of the file assets exists in the target folder already, no files are moved and the results are not as the user would expect. This is the result of a rollback of the transaction and appears as follows:

- Red check marks (indicating a check out) turn blue. The checkout path has already been moved to the new location, so when the file is moved back to the original location but the checkout path is not updated again, the check mark appears blue. These items can be checked in again safely.
- The local copies of not checked out assets seem to be deleted. The local copy of the asset is not actually deleted, it is just not moved back to the original location.
- The file that exists in the target keeps its local copy.

➤ **Bug Number:** UDEVC00039014. Working in a folder during an import causes problems: When performing a large import, working in the same folder you are importing to might cause problems with the import. You might be prompted to refresh your view, in which case the import was successful. In other cases, a message indicates that the import failed and you need to perform the import again, without touching the folder.

➤ **Bug Number:** UDEVC00038766. Get latest on extremely large folder causes problems for user Administrator: When the user Administrator performs a Get Latest on a folder that contains assets in number approaching 50,000, a potential problem might occur; the client slows down, but the operation actually continues. If the client reaches the free memory limit, a corresponding message is shown and the operation is cancelled. This does not occur if another user (not Administrator) has performed a Get Latest on the same machine already.

**Workaround:** Users should perform a Get Latest on the smallest range of items possible, such as a subfolder.

➤ **Bug Number:** UDEVC00039061. Internally used file name appears for Avid Assets renamed to blank name: If a blank name or only spaces is entered in the Rename dialog for an Avid asset, the internally used file name (mob id) appears as the name instead (long string of numbers and letters).
Bug Number: None. Tree state only remembered on the same machine: The tree state upon logout is remembered the next time you log onto Interplay only on the same machine (stored per user, per machine).

Bug Number: UDEVC00040036. Depending on the amount of free memory available to Interplay Access, browsing a folder with thousands of assets or running a search that return thousands of assets can create a low memory or out of memory condition.

If the free memory for Interplay Access goes below 10 MB, a High Result Count dialog box appears with the following options:

- Continue: Continuing the operation will show all results but may create a low memory condition.
- Stop: Stopping the search will display several thousand results depending on the amount of available memory.

Workaround: For searches, limit search results as much as possible by searching in specific folders or using specific fields in the Extended Search. For browsing, avoid keeping too many assets in any one folder. You can also collapse parts of the tree not needed for current operations. This frees memory needed for keeping those parts of the tree.

Bug Number: None. Issues with preview of large text files: Text files over 1MB are not shown in the Preview by default, however, if you explicitly click the Show File button for these large files, low memory problems may occur.

Avid Interplay Administration Limitations

Bug Number: UDevC00106259. In the Manage Database Roles view, if you select multiple roles assigned to a user (for example, Read/Write one folder and Read/Write/Delete on another) and then click Remove Role, an error message (“unknown exception”) appears. Workaround: The roles were correctly deleted. Close the error message.

Bug Number: None. Low disk space issues: In low-disk-space situations, the Administrator cannot log on and shut down the server, and move databases by normal means. There are tools provided to solve such problems (available in the Installation CD’s Tools directory or installed by default in the Server installation directory):

- NxNServerLock.exe
- NxNServerUnlock.exe
- NxNServerShutdown.exe
To move databases under low disk space conditions:

1. Lock the server using NxNServerLock.exe
2. Shut down the server using NxNServerShutdown.exe, if necessary
3. Move the databases to another drive or free up some disk space
4. Unlock the server by doing one of the following:
   - Use the Interplay Administrator’s Lock Server view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details)
   - Use NxNServerUnlock.exe
5. Deactivate any moved databases using the Interplay Administrator’s Manage Databases view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details)
6. Activate any moved databases in the correct location using the Interplay Administrator’s Manage Databases view (see the Avid Interplay Engine and Avid Interplay Access Administration Guide for details)

➤ Bug Number: UDEVC00039474. Passwords should only include ASCII character set: User passwords should only include the ASCII character set. Multibyte passwords might cause logon problems.

Workaround: If logon with a multibyte password fails, the administrator should reset the password in the User Management view of Avid Interplay Administrator.

➤ Bug Number: UDevC00104116. Limitation: In the Interplay Administrator, when specifying a Custom backup location, you cannot browse to an ISIS workspace. You need to type the UNC path.

➤ Bug Number: UDevC00099111. If you apply changes to a roles setting, you might get the following error message: “This version of the Interplay Engine does not support the modification of custom metadata attributes from Interplay Access.” The roles are correctly set, so you can dismiss the error message.

➤ Bug Number: UDEVC00006908. Limitation: Browse for new data location does not show mounted workspaces on Avid Unity™ ISIS® in the tree: In the Create Database view in the Interplay Administrator, when you click Browse in the New Data Location (Assets) section, the mounted workspaces on a Avid Unity ISIS shared storage might not be shown.

Workaround: Type the path manually.
Bug Number: UDevC00007123, UDEVC00039984. Voice over target workspace field says “No Items to Show”: An administrator logged in to the Avid Interplay Administrator may see “There are no items to show” in the Editor Database Settings view in the field Voice over target workspace field instead of the drives. This is intended behavior: the administrator must also be an Avid Unity user with the same credentials in order to see the workspaces of the Avid Unity. If the workspaces are not visible, check that:

- The user is a user on the Avid Unity.
- The user has the same password as the user on the Avid Unity.
- The Avid Unity is reachable.
- The user is allowed to see the workspaces.
- There are actually workspaces at all.

Media Indexer

Bug Number: UDevC00085031. Assist: If you start Interplay Assist while the Media Indexer that monitors shared storage is not available, Assist displays the following error message:

A program error has occurred. If you need assistance record the following information and call Avid customer support. Error assertion failed m_pointer

Workaround: Make sure that the Media Indexer is online and correctly identified in the Interplay Administration tool Server Hostname Settings view. Then restart Interplay Assist.

Bug Number: UDevC00017894 as designed. Media Indexers that are part of a redundancy group must all be on the same subnet or VLAN. You can use the Service Framework Unicast Discovery feature to communicate with Media Indexers on different subnets or VLANs. However, if the Media Indexers are part of a redundancy group, they must be on the same subnet or VLAN. See the Interplay Software Installation and Configuration Guide for details on Unicast Discovery.

Migration from MediaManager to Interplay

The MediaManager to Interplay Migration tools and related documentation are available on a separate CD. See your Avid representative for more information.
**Limitations**

➤ **Bug Number:** UDevC00040002 as designed. Some master clips and subclips imported from a MediaManager environment (also known as Workgroup 4) might appear offline or partially offline.

**Workaround:** Open an Avid editing application, locate the clips in the Interplay Window, and drag the clips to a bin. Then check the files back into the Interplay Window. The clips should now appear online.

**MultiRez**

➤ **Bug Number:** . The following features are not available for this release:

- Multirez relink by tape name and key number.
- Multirez support for pre-Interplay precomputes. This means that if you bring existing sequences into an Interplay environment, you must rerender effects.
- Media files created by rendering effects (precomputes) are not dynamically relinked. If you render effects when they are linked to target settings and then switch back to working settings, the rendered effects will be lost. You can create effects in either mode, but render them only when they are linked to target settings as the last step before output. Render effects in the target resolution only as the last step before output.

**Send to Playback**

➤ **Bug Number:** UDevC00058307 Limitation. When you send media to playback, the Send to Playback dialog box lists two separate bit depth settings: the Target Audio Resolution Bit Depth in the Relink Settings (Input) area, and the Bit Depth in the Audio Mix Settings (Output) area. The Relink Settings indicate the audio bit depth of your target resolution as set in the Interplay Administrator. The Audio Mix Settings match the bit depth settings of your playback device. Since the audio bit depth used by your media must match the bit depth settings of your playback device, your audio bit depth might be converted twice during the send-to-playback operation, first to the bit depth of your target resolution and then to the bit depth of your playback device.

For additional limitations and information on Sending to Playback, search for “playback” in this Readme. Also see the *Assist ReadMe* and the *Interplay Transfer ReadMe*.

**Send to Workgroup**

➤ **Bug Number:** UDevC00081706 Limitation. MediaManager to Interplay Transfer: To perform transfers from a MediaManager workgroup to an Interplay v1.1.x environment, you must have MediaManager v4.5.12 or higher and the related software versions (referred to as Bundle 10a).
**Workaround:** On MediaManager v4.5.10 (Bundle 9), you can use the Avid editing applications to perform the transfer. You can’t use Interplay Access to perform the transfer on MediaManager v4.5.10.

➤ **Bug Number:** UDevC00020533 Limitation. If you select multiple items to transfer to another workgroup, the system might perform more transfers than you expect. For example, if you select three clips and each has two resolutions online, the system performs 6 transfers, one for each resolution.

**Workaround:** Use the resolution bin columns in the Avid editing application so you can tell how many resolutions are online for clips that you want to transfer. Then you can select all of the clips that you want to transfer at a particular set of resolutions. When you transfer multiple clips in this way, the system displays a dialog box that allows you to choose the resolutions that you want to transfer. If you have performed a lot of transcode or redigitize operations, there might be a large number of resolutions associated with a particular master clip.

### Working with Panasonic P2 and Ikegami NLTEK Media

Starting with Interplay v1.6 and the editors that release with Interplay v1.6, you have two methods for capturing media from Panasonic P2 devices.

- Import the files using the “Import and Export Workflow” method as described in the Avid editing application Help. This is the method that was available before Interplay v1.6. For a details on using this method in an Interplay Environment, see “Using the Import and Export Method with P2 Media in an Interplay Environment” on page 89.

- Use the Avid Media Access (AMA) Workflow. This method allows you to work directly with the native files on the P2 card. The files open in a bin on your Avid editing application. You can create sequences with the media or select the clips you want to capture. When you are ready to bring the files into the Interplay environment, select the sequence or clips and use the Consolidate command to create new media files. The Consolidate command copies the new files to shared storage and performs a check-in to Interplay.

You can also copy the native files from the disk or card directly to a folder on shared storage and work with them there before you edit the files and perform the consolidation. This frees up the editor from the process of copying the media files from the cards. For example, a cameraman can copy the contents of several cards or disks to shared storage and then the editor can edit and consolidate the material at a later time. *In this workflow, copy the files to a workspace or folder that is not monitored by the Media Indexer that monitors shared storage.* The Media Indexer only supports the files that are created when you perform a consolidation.
In AMA and “Import and Export” methods, the import or consolidate operation writes the files to shared storage and performs a check-in to Interplay via AAF metadata. Both of these workflow methods are described in the Help for your Avid editing application. See “File Based Media” in the Help. For details on the Import and Export Method with P2 cards, see “Using the Import and Export Method with P2 Media in an Interplay Environment” on page 89.

The Import and Export method allows you to import the proxy media and high resolution media. The AMA method only allows you to work with high resolution.

For this release, the AMA method is only supported for Panasonic P2 and Sony XDCAM HD and XDCAM EX devices. It is not supported for NLTEK devices. Use the Import and Export method for NLTEK devices.

Using the Import and Export Method with P2 Media in an Interplay Environment

This section describes the Import Export method for working with P2 material in an Interplay environment. For information on using the AMA method, see “File Based Media” in the Help for your Avid editing application. For additional information on using the Import and Export method, see “Workflow for editing with P2 Media” in the Help for your Avid editing application.

Supported Panasonic Drivers

See your Avid editing application Readme for the latest supported version of Panasonic driver for this release.

Upgrading to this Release from Interplay v1.1.2 or Earlier

In Interplay v1.1.2 and earlier, the local Media Indexer did not always clear the old P2 configurations from the local Media Indexer if the editor did not perform an Unmount All before quitting the application. After you upgrade, an Administrator should clear any old mounted P2 cards from the Media Indexer configuration on your local editing clients. You can perform the operation on all editing clients from one system as described below.

To clear P2 configurations from the local Media Indexer configurations:

1. Open the Service Framework Service Configuration tool and select the first editing application system.

2. Select the Interplay Media Indexer service and click Configure. The following illustration shows a number of mounted P2 cards. You can identify them because they have a contents\audio and contents\video folder.
Configuring a Local Media Indexer to Index a P2 Reader or P2 Store

To configure a local Media Indexer to index a P2 reader or P2 Store:

1. Make sure the client system was restarted after you installed the P2 driver.
2. Turn on Dynamic Relink. Use the Dynamic Relink settings that fit with your workflow. For example, you could set “if no match found” to “Use Closest Media” and set the Relink Method to “Highest Quality”.

**Dynamic Relink must be turned on.**

3. In the Avid editing application, select Tools > Media Creation.
4. Click “Auto-index local drives as they come online.”
5. Click the Import tab and verify that the settings are correct for the resolution and shared storage location that you want to use.
6. Click OK.

Changing P2 Cards in the Reader

To replace a P2 card:

1. In the Avid editing application, click File > Unmount and select the drive that corresponds to the P2 card you want to replace. (You may find it useful to display the drive letter in a column in the bin.)
2. Remove and replace the P2 card.
3. Select File > Mount All.
4. Open a bin and use the following commands to import metadata and media from the P2 card:
   a. File > Import P2 > Clips to Bin - imports the metadata from the card to the bin and allows you to work on the media files on the P2 card.
   b. Select the clips in the bin and choose File > Import P2 > Media. The system creates new media and stores the media at the location specified on the Import tab of the Media Creation tool.

5. If the media shows as offline in the bin, do one of the following:
   ▶ Double-click the clip in the bin.
   ▶ Verify that Dynamic Relink is enabled and that your settings are correct for the resolution that you are using to capture your P2 media.
   ▶ Verify that you have the Auto-index option turned on in the Media Creation tool.

**Working with Media that Spans Multiple Cards**

Interplay 1.2.x and higher supports importing from spanned media cards. For example, when your recording fills up one card and starts recording onto a second card, its referred to as spanned media.

*Do not check in spanned clips until all cards in the span have been imported. For more information, see “Limitations and Troubleshooting P2 Media” on page 95.*

It doesn’t matter which order you place the cards in the reader. The system will combine the metadata from the card you select and all earlier cards in the span. If an earlier card in the span is not in the reader the system will display that portion of the clip as offline. You can add the correct card later and import the missing media. The system will automatically check the bin for the clip that requires the media.

For example, if you have five cards in the reader and import from the fifth card, the system will combine the metadata from all five cards into one clip. If one of the cards in the span is not in the reader you will see media offline for that span. You can then insert the missing card into the reader and perform an import on that card. The system will capture the media and place it correctly into the original clip.

If you have five cards in the reader and import using the third card, the system captures all of the material up to the third card. You can then import from the fourth and fifth cards and the system will combine the metadata and extend the clip.

*The P2 cards contain information about earlier cards in a span but they do not contain information about later cards in the span. For example, card three in a five card span contains information about cards one through three but it does not contain information about cards four and five.*
For more information on working with spanned media, see the Help for your Avid editing application.

**Mounting Drives and P2 Cards on Avid Unity MediaNetwork**

The P2 Card Reader requires consecutive drive letters when it mounts its cards as drives. If there are other drives mounted in one of the consecutive locations, the P2 Card Reader will skip that letter and not mount the corresponding card slot. This is usually not a problem on Avid Unity ISIS because ISIS mounts drives from the bottom up (starting with Z). But MediaNetwork mounts drives top down starting with the first available letter. If you have gaps in the lettering sequence of your mounted drives, you may have to use the Connection Manager to unmount the drives so the P2 Card Reader can obtain all of the consecutive drive letters that it needs.

You can configure the Connection Manager so that it starts at a particular drive letter. This will ensure that there are consecutive drive letters available for the P2 Card reader.

**To release drive letters for a P2 Card reader in Avid Unity MediaNetwork:**

1. Choose Manage Connections from the Connection Manager pop-up menu and unmount the workspaces.
2. Choose Configure from the Connection Manager popup menu and click the Advanced button.
3. Select a drive letter to start assigning workspaces.
4. Choose Manage Connections and mount the workspaces again.
5. Connect the P2 Card reader and use the Windows Explorer to verify that the cards mount as drive letters.

   The workspaces should now appear in lettered drives below the P2 card reader.

   For more information on using P2 media, see the Help and ReadMe for your Avid editing application.

**Importing from a Copy of a P2 Card on Shared Storage**

This section previously referred to importing from a shared drive. The process is only supported from a folder on Avid shared storage.

In previous releases you could not copy the files from a P2 card to a folder on Avid shared storage and then import the P2 media from the folder. This problem is fixed in the Avid editing applications that ship with Interplay v1.4.x and greater.

*In this document the term shared storage refers to Avid Unity ISIS, Avid Unity MediaNetwork, or Avid LANshare.*
Importing from a folder on shared storage is useful because it allows you to copy the contents of several cards to the folder and then import the metadata for all of the clips using one File > Import P2 > Clips to Bin command. This process also frees up the editor from the process of copying the P2 data from the cards. For example, a cameraman can copy the contents of several P2 cards to shared storage and then the editor can import the clips at a later time.

When you copy the native P2 media onto a folder on shared storage it is important to copy it to a workspace that is not monitored by the Media Indexers (HAG) that monitor shared storage. You don’t want editors to use the native P2 media. They should use the media that is created by the File > Import P2 Media command. The workflow in this section describes a method that you can use to ensure that you avoid working directly with the native P2 media.

To Import P2 Media from a folder on shared storage:

1. Create a folder on Avid shared storage that is not monitored by the Media Indexers that monitor shared storage. This folder will hold the native media from the P2 cards.
2. Create a folder for each P2 card.
3. Attach the P2 reader to the system and copy the data from each P2 card to the corresponding folder. Copy the Contents folder and other files at the top level of the card.
4. Start the Avid editing application and log into Interplay.
5. Turn on Dynamic Relink. Use the Dynamic Relink settings that fit with your workflow. For example, you could set “if no match found” to “Use Closest Media” and set the Relink Method to “Highest Quality”.

Dynamic Relink must be turned on.

6. In the Avid editing application, select Tools > Media Creation.
7. Click “Auto-index local drives as they come online” and click Manual Storage Scan.
8. Check that the Import tab specifies the correct resolution and points to a workspace or folder that is monitored by the Media Indexer HAG.

9. Click OK.

10. Open a bin and select File > Import P2 > Clips to Bin. The system opens the Browse for Files dialog box as shown in the following illustration.

11. Do one of the following:

   - Select the folder that contains all of the P2 card folders. This will import the metadata from all of the P2 cards into the bin. For example, select 052808_6pm_Broadcast folder in the above illustration.

   - Select any one of the individual P2 card folders. This will import the contents of that particular card. For example, select Card 2 in the above illustration.

The system imports the metadata from the cards to the bin as shown in the following illustration. Notice that the metadata is pointing to the native P2 media on shared storage. These clips are being monitored by the local Media Indexer but they are not being monitored by the Media Indexer HAG.
12. Select one or more clips and choose File > Import P2 > Media.

The system consolidates the clips and stores the new media at the location specified on the Import tab of the Media Creation tool. The following illustration shows several of the media files consolidated to a workspace named P2.

13. Check the consolidated clips into the Interplay database.

The editors can now begin working with the clips that are being monitored by the Media Indexer HAG.

**Limitations and Troubleshooting P2 Media**

- **Bug Number:** None. When importing from virtual volumes, it is recommended that both Clips and Media are imported during the same edit session. Otherwise, clips may appear as offline after relaunching the editor application. To recover, select the offline clips and click 'File > Import P2 > Clips to Bin'.
Bug Number: UDevC00092278. When importing spanned clips, you must import the complete span before changing the clip name. If the clip name is changed before the span is complete, the name will be overwritten by the native Panasonic P2 clip name.

Bug Number: UDevC00107998. If after checking out a P2 clip, the system displays "Exception: APlayer:DoComp value of isChunkedAudio changed" error, the clip may be a spanned clip with a section that was not imported.

Important: Do not check in spanned clips until all cards in the span have been imported.

Workaround: If you get the error, import the missing media in the span and then check the clip in again. When you check clip out or Update from Interplay, the clip should play correctly.

Bug Number: UDevC00091182. You cannot perform a partial restore on media that spans across P2 cards. The system restores the entire spanned clip.

Workaround: Perform a full restore of the P2 media. Note that if the media is contained on a single P2 card in the span, the partial restore will work correctly. The problem only occurs when the partial restore media spans across two or more cards.

Bug Number: . If imported P2 media is offline after upgrading your Interplay software, you may need to remove old P2 .pmr files created in your Interplay environment. Delete the .pmr files in the following location:

Local Drive:\Program Files\Avid\Editor Folder\P2

For example, C:\Program Files\Avid\Avid NewsCutter XP\P2

Using an Ikegami Field Pack in an Interplay Environment

This release does not support the AMA workflow for Ikegami field packs (also known as an NLTEK drives). This section describes how to use the Import and Export method to work with Ikegami field packs.

Do not attach the NLTEK drive and the Adrenaline hardware to the same bus on your Avid editing system. Video stuttering can occur if both devices are on the same bus.

To configure a local Media Indexer to index an NLTEK drive:

1. Turn on Dynamic Relink in the Avid editing application. Use the Dynamic Relink settings that fit with your workflow.

   For example, you could set “if no match found” to “Use Closest Media” and set the Relink Method to “Highest Quality”.
2. In the Avid editing application, select Tools > Media Creation.
3. Click “Auto-index local drives as they come online.”
4. Click the Import tab and verify that the settings are correct for the resolution and shared storage location that you want to use.
5. Click OK.
6. Insert the NLTEK drive.
   The Media Indexer will automatically scan the drive as it comes online.

To access the files on the NLTEK drive do one of the following:
▶ Run the Media Tool, select the drive, and drag clips into your bin.
▶ Right-click on a bin and choose Import. Then navigate to the BIN folder on the NLTEK drive and select the CLIPS file.

To switch cards in the NLTEK drive:
1. In the Avid editing application, select File > Unmount and unmount the NLTEK drive.
2. Switch the cards in the NLTEK drive.
3. In the Avid editing application, select File > Mount All.
   The Media Indexer indexes the drive and the media should appear online in the Media Tool. If the media doesn’t appear online, use File > Unmount to unmount the NLTEK drive and then use File > Mount All to mount the drive again.

Partial restore of NLTEK media will fail with a re-wrap failure if the online media files are deleted. As a workaround, perform a full restore of the NLTEK media.